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M,
About Us DIGITAL GROUP

M4 is an IT digital solutions delivery practice. We work closely with our clients to deliver effective technology, and
supply chain management solutions, concentrating on the delivery of real value to support business operations
and end user customers. In an agile, digital world, we assist and support clients to deliver “performance
driven outcomes” that simultaneously align their ICT with both business and customer needs.

The M4 team has, and continues to work closely with, large Government departments to not only manage, but
advise, design and implement end-to-end governance processes and ways of working to support
significant transformation and complex commercial transition and exit activities. Governance developed and
managed by us has covered the complete change lifecycle across agency wide change portfolios, ITIL and GDS
service design and management, and across the procurement landscape. Our team brings highly
experienced expertise in supporting Clients moving from Monolithic to disaggregated IT supply chains.

We recognise the benefits of a successful outcome for all and are highly experienced in negotiating and
articulating ways of working to achieve this aim.

As examples of our government engagements, our teams have supported amongst others, Cabinet Office,
DVLA, SLC, GDS, NDA and The Home Office to deliver a variety of IT programmes and projects.

For transition and transformation programmes our experienced service provisions support and manage
vendor interactions, understanding both user and vendor sides of the equation, to drive best value for money
for the Client whilst interpreting the commercial realities of the Vendor. Our pragmatic approach to
supplementing internal teams with a skillset spanning commercial negotiations and deep technical
understanding drives collaboration, builds confidence and plugs gaps in knowledge to deliver real world
solutions to meet senior stakeholders headline strategic roadmaps.

For more focused product and service delivery initiatives our teams cover the entire scope of software lifecycle
development. We offer increased visibility of the development process, more efficient planning and scheduling and
better cost estimation. The systematic approach to delivering software and services has resulted in man
successfully delivered projects that have continued into maintenance and support programs.
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Case Study
Student Loans Company (SLC)

M4 provided direct support to develop and gain accreditation for a secure path to Cloud Infrastructure for the
Student Loans Company to protect their £17 Billion Loan book. Our team devised the HLD to deliver an
innovative on premises “secure stepping stone solution” to enable a Cloud based content distribution network for
their wider user base to interact via a highly resilient Cloud based elastic front end.

The M4 team ensured success of the Secure Architecture Programme by delivering regular inclusive workshops
on progress and options that continued to address original stakeholder requirements throughout the design
process. Inclusion of the full Client delivery team in decision making and walking through the decision process at
design reviews ensured buy in at all levels and resulted in a “it's my design too” culture with consequent default
upskilling and confidence in the Core Client team. Additionally, M4 also deployed, on an ad hoc basis and at
short notice, technical author coverage to ensure timely completion of all documentation.

Key to the delivery was reusing previously purchased hardware to realise benefit from sunk costs. Also, essential
to this work was the need to bolster in situ ageing infrastructure as well as the ongoing need to protect the Core
database to exacting Security standards, whilst maintaining access to back end data via API’s.

Working with multi-vendor delivery team M4 workshopped the detail, gained local buy in and produced
comprehensive LLD’s ensuring desigh accreditation from SLC CLASS Consultancy team and supporting external
accreditors. During the post documentation phase, we offered ongoing support to ensure successful delivery,
including introducing cyber security tooling into an established ICT Service Management regime to meet policy
and risk mitigation objectives.

Our team continued to support Student Loans through the successful delivery phase once the design was
approved and the team had effectively rolled off the project.

As an aside M4 team members have also contributed the technical input to the Scottish Government RAFE
Report which paved the way for the Scottish Government’s portfolio of Strategic Research designed to ensure
that Scotland maintains its position at the cutting edge of advances in agriculture, food and the environment.
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Case Study
Health Education England (HEE)

NHS HEE operate a multi-disciplinary, Agile environment utilising Scrum methodologies.

During our tenure at HEE we developed and maintained the Cloud Infrastructure and DevOps Platforms and
Processes required by the Trainee Information System (TIS). The M4 consultants engaged on the project had
extensive experience of AWS and Microsoft Azure, including Azure Portal, Virtual Networking and network
security groups. They are adept at containerisation, having experience of Docker, including orchestration &
writing/inspecting Docker and Docker Compose files.

Our service provision has been utilising its knowledge of Ansible automation framework on high availability
application deployments including crossfault domain deployments, availability sets and load balancing
Jenkins CI server configuration and maintenance.

We have also relied upon our experience of Georedundant storage, Linux system administration and scripting
languages in developing platforms.

To monitor and improve platforms the team also used its prior experience and knowledge of Infosec &
penetration testing as well as working in a productive environment with an in-house test team.

The TIS is built on Open Source tooling which M4 configured and deployed in collaboration with other
suppliers on the team.

We also mentored internal junior DevOps resources.
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Case Study
DVLA - DevOps and Cloud Engineering

The objective at the DVLA was the full and secure transition of their Cloud Infrastructure estate involving the
following:

»  Transition to Amazon Web Services; the estate was held in UK Cloud (formerly Skyscape)

»  Migration from Puppet to Ansible

»  Consolidation of Service Automation and Configuration Management

The consolidated outcome resulted in a fully automated, monitored Cloud Platform, with resilient, evergreen
infrastructure and auto-scaling in place.

The resulting best practice system, implemented with adherence to the GDS Service Manual, also offers
increased value for money to the organisation, reduced infrastructure costs, increased transparency of the
running systems, improved reliability through the nature of its components and due to the use of extensive
automation and testing has reduced the number of defects and time to fix defects.

M4 Cloud Infrastructure Engineers worked collaboratively with both DVLA permanent and supplier engineers; this
included engineers from interdependent DVLA teams.

These teams developed and improved the Digital Services Platform in AWS, whilst also bringing other services
such as VVR, SDL, VMPR and SCP in line with the new platform and approach.

Our outcomes also realise the advantages of features available in AWS, which were not previously available in UK
Cloud, thus ensuring that the platform is now not only fully automated, but also properly monitored, with
automated alerting, auto-scaling and disaster recovery solutions in place.

During this engagement M4 also provided pre-agreed levels of out of hours support.
Support of the project was run simultaneously with an extensive skills transfer programme.

The main focus of the transfer programme was genuine enablement as a key outcome coupled with
internal ownership of the delivered solutions.
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Case Study
Government Digital Services
GovPrint

GDS Common Technology Services (CTS) was set up to deliver a range of common technology solutions, including GovPrint,
across government. M4 deployed a service to support this initiative.

M4’s initial remit was to engage with leading hardware and software vendors to share requirements for a shared cloud print
service and discuss the solutions on offer. The main outcome of this exercise was confirmation that there are very few cloud-
native print software solutions and therefore very few solutions that satisfy GDS requirements.

A Proof of Concept/Alpha deployment was implemented to support further evaluation. This identified several technical and
security challenges to be overcome to deliver a secure shared cloud print service.

The technical issues revolved around two key areas. Firstly, how to support user identity from multiple sources i.e. each
government department manages their own identity service. Secondly, the main software solutions are not cloud-native
which lead to a number of issues around networking, security, deployment and management.

It was decided to run GovPrint through two workstreams. The first would undertake user research with key IT decision
makers across government departments. The second would use lessons learned and input from the user research to develop
a GovPrint Concept Design.

M4 undertook interviews with 21 government departments to understand their strategic requirements for print services. This
research identified four common themes:

» A desire to standardise print services across government and migrate to cloud

» A desire to move to a consumption based delivery model

» A need to provide print services and support across multiple locations to an increasingly mobile workforce

» A need to have a simple route to market for utility based services

Using the output from this and the lessons learned, M4 developed a GovPrint Concept Design. This design is based on the

following key principles:

»  SaaS delivery model that supports Public, Private and Community Cloud deliver in a single or multiple tenancy delivery
model

»  Support a Cloud-Native approach e.g. SOA, microservices, containerisation, orchestration and automation

»  Support Software Defined Networks (SDN) using certificates and https as the standard communications protocol

> Multiple GovPrint services that support interoperability between services
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Case Study
Government Property Agency
Hubs GovPrint

Further to the work delivered under the GovPrint Programme for GDS, M4 were selected to assist GPA with
Hubs GovPrint.

M4 worked with Crown Commercial Services (CCS) to undertake a Further Competition under the CCS
RM3781 framework for a shared print service for tenants of the first Gov Hub in Canary Wharf. This involved
defining requirements from all interested stakeholders and using these to create the further competition
documentation.

Four suppliers responded to this requirement and M4 led the independent evaluation of the responses. A
single supplier was selected as the preferred supplier and the procurement entered the Due Diligence phase.

In this phase the initial Proof of Concept highlighted a humber of technical and security challenges. These
areas where thoroughly evaluated and subsequent iterations of the service led to successful deployment
into 4 GPA HUBS.

The contract for the first version of the GovPrint service ended after three years and M4 continued to work
with GPA to procure the replacement service. M4 worked with the GPA commercial team to procure the
replacement service via CCS RM6174. This included using lessons learned from the first iteration of the
service to define requirements for the new service plus supporting supplier evaluation. Once the contract
was awarded M4 managed the deployment of the service including client engagement, service deployment
and service operations. The service is currently projected to roll out to more than 500 locations over the
next 2 years with around 2,700 print devices.
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Case Study
Home Office
Health Monitoring

Cyclamen is the UK’s Radiological and Nuclear (RN) border detection system that plays a key part in
protecting the UK border and is a critical part of HMG’s Nuclear Security Strategy as well as CONTEST, the
Government's counter-terrorism strategy.

Digital, Data and Technology (DDaT) is responsible for leading the delivery of the Migration Borders
Technology Portfolio (MBTP) that comprises programmes and projects to deliver the technology required to
enable the work of Border Force. As a key component of this work, M4 were approached to build a greenfield
scalable monitoring solution to support the new networked Cyclamen system

The scope of this work involved many whiteboard sessions with the Cyclamen Programme, Boarder Forces,
and third-party suppliers. M4 continue to work closely with the Cyclamen Capability Management Unit
(CCMU) to provide a strategic monitoring solution that supports both system health monitoring, along with
custom monitoring designed specifically to aid Border Force.

M4 has designed the solution to be able to integrate with a variety of third-party applications and provides
the end user with an easy visual representation of their systems in real time.

To ensure that the solution meets ongoing changes in technology and business requirement regular updates
and enhancements are designed and implemented by M4.
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GDPR & Cyber Essentials Plus

With the recent introduction of The General Data Protection Regulation (GDPR) (EU)
M4 Digital Group have grasped and implemented a responsive, dynamic approach

to the handling of personal data to ensure compliance with the regulation and to
have the ethos of the principles and rights at the core of our business operations.

For our full privacy policy, please see our website. CYBER
ESSENTIALS

M4 are also accredited with the Cyber Essentials Plus award.

M4 can bring our experience in delivering processes
to support Clients to achieve compliance to the CEEELFSIED
scheme.
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Service List

Agile Business Change

Alpha

Application Service Design and
Implementation

AWS Platform and Integration
Service

Azure Platform and Integration
Service

Beta

Business Analysis for Cloud
Transition

Business and Systems Analysis

Business Resilience for Cloud
Services

Cloud Architecture Design Services

Cloud Based Target Operating
Models

Cloud Build and Delivery

Cloud Business Process Analysis

14

15

16

17

18

19

20

21

22

23

24

25

26

Cloud DevOps Services

Cloud Load and Performance Testing
Service

Cloud Migration Test Service
Cloud Migration, Replication and
Integration

Cloud Performance and Testing Services

Cloud Readiness Assessment

Cloud Services Development and
Support

Cloud Enables Print Services — Audit

Cloud Systems Engineering Service
Cloud Testing Services
Cloud Transformation Programme Test

Management Service

Cloud, Network and Information
Security & Testing Service

Data Architecture , Analysis and Cloud
Design Service
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27

28

29

30

31

32

33

34

35

36

37

38

39

Data Cleaning, Mapping and Cloud
Migration

Digital Print Services

Digital Print Services — Cloud Platform
Enablement

Digital Print Services -
Implementation Enablement

Digital Print Services — Strategic
Sourcing

Digital Transformation Service

Discovery

Exit & Transition; Requirements
Delivery

Exit & Transition; Vendor Migration

Exit & Transition; Business
Transformation Support

Exit & Transition; Internet Service
Migration and Cloud Readiness
Security Assessment

Exit, Transition & Transformation;
Lifecycle Support

Exit & Transition Migration of Services
from Private and PSN Networks to
Internet and Cloud




40

41

42

43

44

45

46

Service List

Continued

Exit & Transition; Security 52
Framework Alignment Assessment

and Support

Exit & Transition; Vendor Exit and 53
Client Service Transition Support

PSTN Switchover 54
Exit from Legacy Core Services 55
Functional Testing Service 56
Google Cloud Platform and 57
Integration Service

Identity Assurance and Access 58
Management

Information Security Service 59
IT & Cloud Transformation 60

Assessment and Capability

IT Enabled Business 61
Transformation

IT Security and Architecture 62

Legacy Infrastructure Path to Cloud 63
Migration

Microsoft System Centre Operations
Manager Service

Microsoft Cloud Services

Microsoft 0365 Integration and Cloud
Migration Services

Microsoft System Centre Assessment
Services

Migrate away from legacy to Cloud
Migrate away from Legacy Core
Services to Alternative NTP Service

Migrate Email to the Cloud

Monitoring and Alert Management
Service

Network and Systems Health Monitoring
Service

Open Source Cloud Computing
Database Migration

Penetration Testing Services

PMO and Project Management

Quality Testing for Cloud Deployment
Service
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65

66

67

68

69

70

71

72

73

74

75

Secure Migration of Legacy Systems
to Cloud

Secure Transitional Architecture
Design, Delivery and Integration to
Cloud

SIAM Support Service

Software Quality and Testing Service

Solution Architecture, Design and
Delivery

Supply Chain Disaggregation
Support

Supply Chain Transformation
Support

Supporting and Expanding Internal
Transition Capabilities to Cloud

Technical Delivery Management

Test and Quality Assurance for Cloud
Deployment Service

Test Automation Service

Test Management Service




Service List
Continued

76 Test Augmentation Services 78 User Research for your Cloud Journey 80 End point vulnerability management
and remediation

77 User Acceptance Test Service 79 ITAM - IT Asset & Software Asset
Lifecycle Management
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1. Agile Business Change /

We create Agile Cloud solutions that can be deployed quickly and meet

the needs of Agile business projects. We positively impact solution

development and DevOps, leading to rapid response iterative software DIGITAL GROUP
production. M4’s service relies upon an informed and tailored approach

specifically designed to address customer requirements and user

needs..

Service Features Service Benefits

» Support Agile Cloud transformations through
Agile business change management

» Establish parameters for change; rapid v
more measured approach

» Drive change with one team, one goal
attitude

» Engagement with staff and creation of a
collaborative approach

» Continuous review and application of output reviews
learning . . Increased levels of communication, collaboration

» Transforming employees into a “change and feedback
enterprise”

» Enabling staff with new skills and
capabilities

»  Short sharp sprints with frequent delivery of
value

»  Puts business value first

» Full enablement programme encouraging
long term change

Value of experienced supplier/partner

Remove blockers to organisational change
Run change in multiple parallel phases
Improve timescales to delivery

Improve quality of output

Develop a culture of continuous improvement
Develop an atmosphere of higher team morale
Increased cost control via sprint financial and

VVvVvVVvVVVYVYYVYY

v
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2. Alpha /

M4 are highly experienced in Alpha phase initiatives. We take the

outputs from Discovery, build services, test prototypes with users and DIGITAL GROUP
demonstrate that the build is technically possible. Once Alpha has been

completed we highlight design issues, risks and associated costs that will

inform a decision to move into Beta

Service Features Service Benefits

» Tests the hypothesis from Discovery » A clear understanding of what is required for
» Adherence to GDS best practice guidelines Beta
» In-depth knowledge of open standards » Iterative Agile development allowing
» Considered alignment to business strategy incremental and rapid delivery
» Focus on risks, dependencies and integration » Improved user experience

to wider services » Embeds new ways of working with use new
» Experienced team capable of rapidly iterating technologies

solutions » Encourages behavioural change to realise
» Iterative prototype development ensuring benefits

continuous improvement » Bespoke, flexible ways of working to meet
» Timeboxed delivery, typically 8 weeks your business needs
» Focus on the end-user experience and usability » Validation of requirements, technical
» Testing - user, business and technical needs feasibility and user needs

» Encouraging stakeholder buy-in employing
visual design

» Provides the ability to estimate costs

» CI/CD approach
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3. Application Service Design and /
Implementation

M4 has been successfully engaged on Cloud-based Digital Services D|G|TAL GROUP
and transformation programmes across UK Public Sector.

Tailoring our approach to match client needs whilst also adhering to
government-driven design priorities we deliver economically
advantageous, open source, reusable solutions

Service Features Service Benefits
» Adherence to GDS best practice guidelines » Experienced in Government standards
» Cloud solutions aligned to business strategy and assessments
» In-depth knowledge of open standards » Flexible and bespoke delivery approach
» Experience in digital, open source, Cloud » Improved user service experience
applications and services » Innovative design, enabling organisations
» Focus on integration to wider services to leverage the latest technology/tooling
» Experienced design and delivery teams »  Structured knowledge transfer process
deployed » Create consistency and cohesion across
» Iterative development ensuring continuous services
improvement » Testing - user, business and technical
» Delivers re-usable components needs
» Focus on the end-user experience and usability » Agile implementation of cloud-based
»  Micro services architecture solutions

» Embeds new ways of working with use
new technologies
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4. AWS Platform and Integration Services /

This service provides guidance and assurance to deploy, transform and

migrate to AWS Cloud Technology. Experienced and qualified M4 team

members will assist with the development of an DIGITAL GROUP
integration/transformation model that importantly also addresses

cultural change issues and provides for the build of scalable and elastic

IT-enabled capabilities

Service Features Service Benefits

» Accelerate delivery of ultimate business »  Efficient adoption and transition
outcomes » Realisation of material cost savings

» Enable innovation via continuous » Higher level of business user satisfaction;
delivery of new service capabilities distributed budget spend

» Optimise maximum agility » Provides for continuous delivery

» Maximise benefits of increased » Provides for Agile development
functionality and security features » Provides for automated test and design

» Scalable, elastic solution » Improve levels of virtulisation, standardisation

» Solid AWS platform design and automation

» Experienced and knowledgeable » M4 drive cultural change increasing cloud
DevOps, System Integration and adoption rates

Platform Architects

» Experienced assistance with Iaas, PaaS
solutions selection

» Best in class Web Ops capabilities

» Strong focus on principles of Cloud
Security
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5. Azure Platform and Integration Services /

This service provides for guidance and assurance to deploy, transform,
and migrate to Microsoft Azure Cloud Technology. Experienced and DIGITAL GROUP

qualified M4 team members will assist with the development of an
integration/transformation model that importantly also addresses
cultural change issues and provides for the build of scalable and elastic
IT-enabled capabilities.

Service Features Service Benefits
» Experienced and knowledgeable DevOps, » Realisation of material cost savings
System Integration and Platform Architects » Accelerate delivery of ultimate business
» Bestin class Web Ops capabilities outcomes
» Strong focus on principles of Cloud » M4 drive cultural change increasing cloud
Security adoption rates
» Provides for continuous delivery » Higher level of business user satisfaction;
» Experienced assistance with Iaas, PaaS & distributed budget spend
Baa$S solutions selection » Improve levels of virtualisation,
» Provides for Agile development standardisation and automation

Optimise maximum agility
Efficient adoption and transition
Solid Azure platform design

» Scalable, elastic solution

» Enable innovation via continuous delivery
of new service capabilities

» Provides for automated test and design

» Maximise benefits of increased
functionality and security features

vVVvyy
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6. Beta /

M4 are highly experienced in Beta phase initiatives. We develop outputs
from Alpha, and ensure they meet Digital Service Standards, DIGITAL GROUP

government accessibility requirements and service assessment pass
levels. We specialise in delivering cost-effective continuous Beta
iterations that meet user needs and deliver value early and often

Service Features Service Benefits
» Collaboratively plan/manage a Beta phase that » Experienced in Government standards and
builds on Alpha Beta assessments
» Adherence to GDS best practice guidelines & » Refine services based on user needs
Service Standards » Improved user service
» In-depth knowledge of open standards »  Embeds new ways of working with new
» Considered alignment to business strategy technologies _ _
» Focus on risks, dependencies and integration »  Encourages behavioural change to realise
to wider services beqeﬂts N o
» Experienced delivery teams deployed » Delivers a digital service fit for Beta
» Iterative development ensuring CI/CD assessment
» Delivers re-usable components » Roadmap for a smooth transition to live
» Focus on the end-user experience and service
usability » Agile implementation of cloud-based
» Testing - automated, continual and quality solutions
assured » WCAG knowledge
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7. Business Analysis for Cloud Transition /

Business Analysis is a vital part of Cloud transformation, transition and

migration and ensures that user/operational needs are understood and DlGlTAL GROUP
factored into the design of robust digital services. M4's Business

Analysts bring significant strength through expertise. Our adaptive,

partnership-based approach helps clients achieve Cloud

transformation/transition/migration goals faster.

Service Features Service Benefits

» Identification of and engagement with key » Improved operational efficiency from effective
stakeholders process design

»  Facilitating workshops to elicit and » Increased team productivity
confirm Cloud requirements with » Better reflection of operational needs and
stakeholders blockers in service design

» Creation of user stories and backlog » Maximised return on investment through pro-
refinement active cost/benefit analysis

» Cost/benefit analysis on features and » Earlier realisation of Cloud transformation
products benefits

» Business Process Modelling and » Legacy integration for more effective
optimisation using industry standard transition to Cloud hosting model
techniques » Agile and iterative

» Identification of blockers, challenging » Use of collaboration tooling e.g. Jira,
where appropriate Confluence and Bitbucket

» A variety of methodologies including » Collaboration with development team

Agile, DSDM, Kanban and PRINCE
» Experts in UK Government Cloud
transition projects
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8. Business and Systems Analysis /

With the frequent and rapid change in hardware, software and business

procedures M4’s Business and Systems Analysis team work with clients

to enhance business performance. We assist with data analysis, DIGITAL GROUP
cost/benefit analysis, systems review and prioritisation of researched

user needs geared towards aligning technology with business strategy.

Service Features Service Benefits

» Use Agile, Waterfall or Hybrid approach to » Follow the GDS Lifecycle, Standards and
deliver change Manual

» Access to high level Business Analysts that » Experience in delivering in complex, high
provide thought leadership performance operating environments

» Gathering of service, functional, non-functional » Improved service quality
and business requirements » Experienced in digital, Open Source and Cloud

» Requirements Management and change control applications and services

» User needs, backlog prioritisation and MVP » Experienced in working collaboratively within
analysis multi-supplier teams

» Translation of business objectives into effective » Innovative cloud solutions designed and
technology solutions assured

» Documentation of contract and commercial » Advanced functionality and service quality
requirements » Reduced costs

» Business Process Modelling and design » Enablement - Transition of knowledge and

» Proficient in gather Discovery outputs for Alpha skills to staff
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9. Business Resilience for Cloud Services /

M4 has real-life, current experience of planning resilient multi-vendor
cloud/hybrid Government services. These services ensure Business
Continuity, merging legacy systems with new Cloud services, anticipate

potential failure scenarios and provide cost-effective solutions. Our DIGITAL GROUP
expertise includes resilience strategy, business continuity planning,
cyber-security, business impact risk analysis, testing/training/incident
management, and regulations/standards alignment.

Service Features Service Benefits

» Understanding the criticality and practicality of » Resilience focused on Cloud services able to
Cloud provided Public Services support critical priorities

» Providing a structured approach to a Gap » Clarity of resilience requirements against
Assessment industry best practice

» Using Business impact and Risk Analysis »  Ensure critical technology, suppliers,
covering all solution elements people, processes and premises are

» Focus on Cloud/legacy services: resilient
infrastructure, platforms, software, suppliers » Resilience across infrastructure, platforms,

» Targeted training and awareness for critical software, suppliers
people and teams » Develop, implement, manage and

» Business continuity, crisis and incident continually improve resilience frameworks
management, disaster recovery, cyber » Governance to preserve the reputation of
resilience delivery organisations

» Resilience governance and associated policies, » Ensuring RTO and RPO objectives are met
standards and controls following an incident

» Integration of Cloud/legacy services within » Ensuring legacy considerations as part of
Government and supplier resilience the wider picture
programmes

» Providing the tools to handle a major incident
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10. Cloud Architecture Design Service /

Through M4’s approach to cloud architecture design, our team of highly
experienced architects will assess your workload and application needs DIGITAL GROUP

to choose the right Cloud platform and design. Experienced in
developing and co-ordinating Cloud architecture and design across a
variety of disparate areas we focus on collaborative/informed solutions

delivery.
Service Features Service Benefits
» Evaluate Cloud architecture design »  High calibre experienced team offering
requirements via workshops and facilitated informed Cloud architecture design
sessions solutions
» Delivery of a risk managed architecture »  Reduce the risk of a poorly planned
roadmap migration
» Ensure Cloud architecture design through » Ongoing post design support
testing and proof of concept » Optimises Cloud architecture to create
»  Tailor Cloud architecture design solutions secure platform for digital services
specifically to meet your requirements » Bolster eX|§t|ng team with experienced M4
» Analysis of business/technical goals as Cloud Architects
well as underlying road map » We will help you think “adaption” and
» On demand advice for storage “elasticity”
requirements, database sizing, shredded » Enterprise scale

storage
» Generate solid, pragmatic delivery plans
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Design

User demand is challenging organisations to rethink digitally-driven
growth strategies; M4’s service is designed to leverage Cloud based DIGITAL GROUP

potential and meet those challenges. Extracting synergies and improving
performance at both technology and financial levels, our service assists
you to redefine your TOM and deliver positive outcomes in a digital

11. Cloud based Target Operating Model M{

world.
Service Features Service Benefits

» Review and analysis of existing organisational » Identification of issues and opportunities for
operating models optimisation and improvement

» Design of an effective Target Operating Models »  Vision of organisation defined and
that leverages Cloud communicated to stakeholders

» Creation of a risk, issue and opportunity matrix ~ »  Defines the roles, skills and staff required

» Transition roadmap » Manage and reduce complexity

» Defines organisation strategies that leverage » Increased operational efficiency and operating
cloud technologies model performance improvement

» Business case development » Innovative design, enabling organisations to

» Technology sourcing strategy leverage the latest technology N

» Specialist knowledge of commoditised cloud » Improved business design delivering efficient
services services

» Scalable » Enablement - skills and knowledge transfer

»  Utilises best practice with design specific to
your business

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



12. Cloud Build and Delivery Service /

This service assess user needs and your current state IT. M4 are hugely
familiar with delivery of new and transformational builds for services,
migrating from traditional on-prem to scalable, secure, Cloud
transportable applications. We are equally comfortable building new
applications leveraging performance tools and Cloud Vendor
performance enhancements.

DIGITAL GROUP

Service Features

Proven value for money, benefits first
MVP, iterative delivery

Experienced teams delivering across
Government to Digital Service Standards
Reusing open source, compliant open
standards to reduce delivery time

Fully supported delivery teams to assist in
multi-Vendor environments

Full stakeholder engagement and user
needs based milestone delivery
governance

Experienced in enablement of available
vendor cloud optimisation solutions
Engaged in government development
communities enabling sharing/transfer
knowledge and innovation

Experienced in leveraging Gov.UK
common tools and shared infrastructure
Reuse, and adapt existing patterns and
Cloud Infrastructure optimising delivery
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Service Benefits

Delivers scalable, reusable, open-source,
portable applications

Reusing code optimising delivery
timescales and removing duplication of
effort

Experienced developers matched to
Architects skills and deliverables
Delivery supported by internal
community of Architects and thought
leaders

User needs first approach to delivering
early MVP, minimising cost

Skilled in transforming and reusing
existing infrastructure to support
delivery

Agile

Microservices architecture utilised where
pertinent

CI/CD




13. Cloud Business Process Analytics /

M4’s Cloud Business Process Analytics Service designs, documents,
analyses and optimises business processes relying upon our in-depth DIGITAL GROUP

Business Process Analysis and Business Process Re-Engineering
experience to deliver cost efficiencies and improved performance
levels through the exploitation of ever-evolving Cloud technology.

Service Features Service Benefits

» Identifies opportunities for simplifying > Pr_ocesses exploiting Cloud technology in line
processes through thorough review with Government strategy

» Stakeholder and supplier » Agile implementation of Business Process
identification and management Improvement

» Translates strategy into process » Faster time to deliver Cloud based process
improvement improvements -

» Evaluates process use, efficiency and » Reduced operating costs
cost reference » Increases operational efficiency

» Establishes a model for continuous » Departmental view of efficiencies and
improvement impact change:s ‘

»  Gathering of process insights, and » Improved quality of service -
identification of critical steps > AllgnS_ core business processes with

» Integrates opportunities for Cloud organisational goals
technology » Enablement - knowledge and skills transfer

» Delivery approach that adapts to » Assistance with procurement and
your needs commercial activity where required

» Programme & Change Management
Support

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



14. Cloud DevOps Services /

Experienced service line providing clients with a pragmatic approach

to establishing DevOps capabilities in organisations and offering

improvement within technology and automation.

M4’s service provision covers deployment process automation, DIGITAL GROUP
continuous integration, test automation and continuous delivery.

We are flexible in our approach and our solutions adhere to

government-defined best practice.

Service Features Service Benefits

»  Minimum disruption from development through » Track record of public sector service provision
release » Supports test data management

» Maximise use of CI/CD » Highly automated security testing

»  Agnostic provider of Cloud services and » Deploy code more frequently and get into
technology production faster

» Development of delivery focused environment » Version control for all product artifacts

» Automation of deployment processes » Create scalable test environments that match

» Test automation prodyction o

» Introduction of cross functional teams and »  Eradicate big risk release; develop, test,
increased levels of automation deploy via manageable microservices

» Continuous monitoring » Baa$S development

» Open source, scaleable development

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



Service

M4 provide cost effective Test Services, including Cloud Load,

Performance and Load and Performance Testing determining DlGlTAL GROUP
how systems perform against specific performance criteria. Tools

used include but are not limited to HP LoadRunner, IBM Rational

Performance, NeolLoad, Eggplant Performance; Open-source

performance tools, JMeter, BlazeMeter, The Grinder, Gatling

Service Features Service Benefits

15. Cloud Load and Performance Testing M{

> Define Performance Strategy/Approach »  Specialist Technical Cloud Performance Testing
» Performance Test Management Skills
> Eerzormance 'tl'esttSI;De_smtJ_n argj ISet Up »  Flexibility of Agile Delivery
> erformance 1est Scripting Lelivery » Reducing delivery lead time by the provision of
» Performance Test Execution . -

Analvsi dR i skilled specialists
> naIYtS|sAan eporting » Alignment with GDS design manual
> ?u? |”y ti ssuragcce fi i f Test » Reducing project downtime
g Tnosolas ation and L-onfiguration of 1es » Taking control of your solution quality

. » Quality control and process improvement

» Tools, HP LoadRunner, IBM Rational »  Knowledge transfer

Performance, Open-source performance,

JMeter. BlazeMet » Enablement

eter, blazeeter » Collaboration

» Consultants carry active Government
clearances - SC and Disclosure Scotland

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



16. Cloud Migration Test Service

Organisations moving to the cloud or across clouds, without scheduling
appropriate testing, risk server breakdown issues, database errors, and
application and website crashes. M4 provide cost effective Cloud Test

b

Services including, Cloud Migration of services between Cloud Providers
or from Legacy estate to Cloud Platform(s) designed to avoid these

pitfalls

M4 Digital Group- Combined Service Descriptions - G-Cloud 14

Service Features

Production of Migration Test Strategies
and Test Plans

Pre and Post Migration Test
Planning/Scheduling

Integration, Performance, Automation,
Security, Operational Acceptance,
Accessibility, UAT

Production of Migration Test Cases and
Test Scripts

Cloud IaaS, PaaS, SaaS testing models
Support ERP, packaged application, open
source software

Quality and test driven development
Procurement and contract exit

Testing tools from Industry standard HP,
IBM Rational, Collaboration Tools
Consultants carry active Government
clearances - SC and Disclosure Scotland

A\ A A 4 vy

vy

Service Benefits

Applications/Service fully Tested prior
to Migration

Business User Acceptance Testing
Reducing delivery lead time by the
provision of skilled specialists
Alignment with GDS design manual
Reducing project downtime

Taking control of your solution quality
Quality control and process
improvement

Knowledge transfer

Enablement

Collaboration

DIGITAL GROUP



17. Cloud Migration, Replication and M{
Integration I_

M4 provide a Cloud migration service for data, applications and
services which insist that maximum benefits are obtained from such an DIGITAL GROUP
activity. This includes replication in alternative Clouds to provide multi

Cloud deployment and operational hosting scenarios to provide HA, DR
and work load hosting options.

Service Features Service Benefits
» Multiple Cloud service management integration » Reduced vendor lock in
solutions » Reduced operational costs
»  Migration and replication candidate » Reduced migration and replication costs
identification, planning and roadmap » Greater control
development » Greater benefits realisation
» Specialists in AWS and Azure migration and » Improved service quality
service replication » Increases flexibility
» Data cleaning and transformation » Improved delivery using a variety of

» Application and service transformation methodologies

»  Utilisation of Cloud communities and utilities » GDS technology Code of Practice and Cloud
and services in First Strategy knowledge

»  Multiple Cloud deployment technical and » Smooth transition and adoption

operational analysis

» Cloud optimisation service

» IaaS, PaaS and SaaS integration, migration
and replication service

» Hybrid development, system and service
integration and governance

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



18. Cloud Performance and Testing Services M{

Our Cloud Performance and Testing Service Provision provides clients
with a wide range of professional testing services, including functional
testing, load testing, stress testing, test automation, non-functional
testing (such as performance, security and accessibility), test strategy,

DIGITAL GROUP

test management and test guidance for developers.

Service Features

) ) »  Successful product delivery as part of
» Testing of software products produced by agile integrated agile teams
teams _ _ _ _ »  Multi-disciplinary team testing and
» Test Automation SUI?IDOthQ rapid promotion of development ensuring immediate test feedback
products to Production Environment » Improved scalability and performance of
» Test guidance for developers applications
»  Performance test design and setup » Integration of functional and non-functional
» Performance test execution testing within single team
» Advising on BDD and TDD approaches » Reduce regression issues with effective test
» Performance, Load, Stress and Soak testing automation
supporting assurance to Production _ » Reduction of testing tools cost through open
» Disaster Recovery Testing of digital services source technology use
»  Analysis and reporting _ » Reduced risk when delivering value to users in
» Advising and supporting clients for UAT production
activities to signoff » Reduce application down time

M4 Digital Group- Combined Service Descriptions - G-Cloud 14

Service Benefits




19. Cloud Readiness Assessment

Experts in Collaborative working across Government, delivering strategic
support to clients, assessing organisational and technical capability,
identifying key risks/weaknesses in current/proposed designs, suitability
of applications and workloads for transition and transformation,
redesigning around potential points of failure. Proposing solutions and
supporting delivery of scalable repeatable tried and tested solutions.

b

DIGITAL GROUP

Service Features

» Assessment and remediation of all >

infrastructure, networks, security, Cloud

capabilities >
» Delivery of full transitional roadmaps with key

agreed milestones >
» Identification of key dependencies and possible

orphan services >
» Alignment of Cloud Transition Strategy to client

TOM >
» Thought leadership delivering path to Cloud

and vendor exit planning >
» Delivering solutions in line with Government

Digital Service Standards >
» Integrate, adapt new and old services to

scalable Cloud solutions >
» Experts in assessing impact on business of

architectural change >

» Minimise disruption of service, enhance user
experience and remove cost

» Identify risk and cost benefits in leveraging
transition for transformation

M4 Digital Group- Combined Service Descriptions - G-Cloud 14

Service Benefits

Enablement of client existing teams assessing
technical and operational capability

Examine and support recommendations for
reuse, redesign or replace

Commercially aware technical team assess
readiness supporting decision making
Minimise impact to live service, minimise
change fatigue, retain resilience

Scalable, reusable solutions minimise time to
deliver, using established methodologies
Highly experienced team with wide public and
private sector exposure

Experienced in delivering Vendor independent
Transition and Transformation

Upskilling client teams, supporting
development and leadership skills

Strategic support where required, experienced
critical friend in vendor negotiations



Support

M4 provides planning and delivery services for digital Cloud applications
focused on user needs. We also provide architecture, DevOps and DIGITAL GROUP

WebOps services to supplement the development capabilities. We utilise
standards and use Open Source software, development frameworks and
tools hosted in the Cloud.

20. Cloud Services Development and M{

Service Features Service Benefits
» Digital development and Cloud transition » Rapid delivery of Cloud based digital platforms
»  Delivery via various industry standard » Reduced costs and increased flexibility through
methodologies Open Source and Cloud
» Digital delivery and development through Open » Integration with GOV.UK website for digital
Source tools and software transaction

» Operate within Prince2, TOGAF and SAFe
» Continuous integration services
» Follow the GDS Digital Service Manual,
standards and lifecycle Java, .Net, SQL, JSON, Web Services
» Provide DevOps, WebOps live operations and Increase value and lifespan of legacy through
support services Cloud integration
» Replacement and transition from legacy
systems, services and applications
» Commercial transition and exit from vendors,
suppliers, incumbent

Integration with key legacy applications
Enablement
Reduced costs

VVvVVyYVYY
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21. Cloud Enabled Print Services - Audit M{

Prior to a successful cloud deployment M4 run an audit and procurement
program where all data relating to assets, locations, volumes, DIGITAL GROUP

applications, and user counts are gathered. We do this either via our
online visualisation software that scans networks to collect the pertinent
information or via physical audit if necessary

Service Features Service Benefits
» Assessment of assets, volumetrics, locations » Flexible project teams with no additional
» Analysis of user requirements overheads
» Current state design » Agile roll on and roll off expertise as required
»  Future state design » Low cost assess and design service
» Detailed multi site design for Business Case » Obligation free
approval » Accelerated expert understanding of CMO and
» TCO and benefit realisation including TCO
reprocurement activities » Vendor agnostic assistance offering neutral
» Scenario modelling cost v convenience v review
functionality » Speed and avoidance of extended procurement
» Floor mapping and what if planning cycle
» Tailored specialist print requirements » Future proofing and extensible platform
» Software application design including cost model » Detailed report for sourcing approach and
analysis strategy
» Benefits » In depth commercial and procurement

capability

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



22. Cloud Systems Engineering Service /

M4 provide Cloud Systems Engineering services spanning the entire

digital spectrum. Our experienced teams of digital technology experts

provide a full portfolio of services from cloud strategy, readiness DIGITAL GROUP
evaluation and roadmap creation through to end to end cloud

engineering and seamless deployment and post go live support.

Service Features Service Benefits
» Define cloud strategy » Bespoke, flexible ways of working to meet your
» Cloud readiness evaluation needs
» Roadmap creation o _ » Aligned with GDS Service Design Manual
»  End-to-end cloud engineering including » Integrated approach leads to improved
development and testing outcomes
»  Migration of existing applications and systems » Integrates into existing suppliers and tower

onto cloud infrastructure delivery models
»  Secure integration to all existing and third- Provides flexible outcomes to digital projects
party systems Manage and reduce system complexity
» Microservices architecture and application Experts in Cloud platforms
development and integration Reduced operational costs
» Seamless deployment and real-time support Enablement - skills and knowledge transfer
» Requirements engineering and analysis,
lifecycle design, tailoring and reviews
» Suitable to deploy to public, private or hybrid
virtualised environments

VVvVVyYVYY
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23. Cloud Testing Services /

M4 Test Services provide access to full testing experience and
insight. Collaborative working methods, highly efficient techniques
and innovative technology are accessed across our portfolio of Test D|G|TAL GROUP
Consultancy, Test Management Governance, Functional Testing,
Integration Testing, Non-functional Testing, and Test Automation,
Performance Testing, Test Data Management, Quality Assurance,
User Acceptance Testing.

Service Features Service Benefits
» Experienced Test Professionals » Cost-effective high quality testing services
» Bespoke test tool creation » Efficient test automation
» Test project remediation » Faster time to market, delivered to
» Flexible, tailored engagement model production using shorter iterations
» Testing as a Service » Shorter delivery cycles minimise delivery
» Risk-based testing risk
» On-site or off-site » Increased operational efficiency
» Managing Software Testing Programmes » Continuously improved business service
» Test Management » Flexibility to ramp up test teams to meet

demand

» Cost effective flexible model
» Delivery methods Agile, Lean, SCRUM,
Kandan, TDD/BDD, Waterfall, Prince 2

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



24. Cloud Transformation Programme /
Test Management Service

M4 provide Cloud Transformation Test Management services to
plan, manage and coordinate all aspects of testing through entire DIGITAL GROUP
project lifecycles. Experienced Test Teams provide leadership and

mentoring and define test policies, test strategies and assist with
test planning and reporting. Our service ensures projects delivered

on time and to budget.

Service Features Service Benefits

» Inception to delivery utilising Model, Processes, Reducing Operational Costs

Strategies and Work Practices Increasing flexibility
»  Software Delivery, Technical Refresh, Data Reducing delivery lead time by the provision of
Migration, Cloud Migration, Contract Exit skilled specialists
» Integration, Performance, Automation, Alignment with GDS design manual

Security, Operational Acceptance, Accessibility, Reducing project downtime
UA Testing Taking control of your solution quality

»  Waterfall, V-Model through to Agile Quality control and process improvement
incorporating Scrum and hybrid approaches Knowledge transfer

» Cloud IaaS, PaaS, SaaS testing models Enablement

»  Support ERP, packaged application, open Collaboration
source software

» Quality and test driven development

» Procurement and contract exit

» Tools from Industry standard proprietary
tooling provided by HP,IBM Rational

» Consultants carry active Government
clearances - SC and Disclosure Scotland

vVvvyy

VVVvVvVVVYVYY
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25. Cloud, Network and Information /
Security & Testing Service

Our Managed Service supplies CLAS and SC cleared security and
testing consultants, or teams. We support projects across Cloud DIGITAL GROUP

Infrastructure, Applications Development, Desktop and End User
Computing, as well as Network and Internet Security across
government, digital and financial sectors.

Service Features Service Benefits
» Developing cloud deployed security policy, » Minimise internal and external security threats
strategy and standards » Simple transformation and service integration
» Delivering security controls, architecture process
and design using Waterfall and Agile » Reduced delivery costs through open source
» Liaising with security vendors, suppliers deployment
and external resources » Alignment with GDS Design Manual
» Maintaining security applications for end » Reduced delivery lead time
user computing and mobile devices » Enablement and knowledge transfer to internal
» Providing support in cloud infrastructure, staff
storage and network service » Taking control of your network and
» Audit and review of current cloud security information security management
policy and procedures » Collaboration and enablement
» Classification, IL2, IL3, CLAS, » Testing
» Support end user, data centre, hybrid, » Test Automation

private and public cloud
» Testing Services
» Quality Assurance Services

M4 Digital Group- Combined Service Descriptions - G-Cloud 14




26. Data Architecture, Analysis and /
Cloud Design Service

M4 can deliver information and data architecture, analysis and Cloud
design. We define Cloud requirements and develop strategy and design DIGITAL GROUP

to implement industry standard Cloud services. Our service provides an
enterprise wide roadmap with the ultimate goal of delivering a well
planned, careful and fit for purpose solution.

Service Features Service Benefits
» Reduced operational costs
» Client consultation and assessment of Cloud » Reduced migration costs
architectural approaches »  Service accountability
» Cloud architecture strategy, roadmaps and » Flexible and scalable approach
migrgtipn p_Ianning _ _ » Improved service quality
» Specialists in AWS and Azure Migration » GDS Technology Code of Practice and

» Cloud and Data Centre optimisation and Cloud First Strategy knowledge

migration Managed service delivery
» Data, application and service migration to Specialised knowledge transfer
Cloud service offerings

» Make data governance a priority

»  Multiple Cloud deployment technical and
operational analysis

» IaaS, PaaS and SaaS integration, migration
and replication service

» Define which data is most valuable and why

vy
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27. Data Cleaning, Mapping and Cloud /
Migration

M4 provides a migration service for data, applications, and services

which includes ensuring that maximum benefits are obtained from such DIGITAL GROUP
an activity. Pre-migration analysis is conducted to identify the potential

value areas and benefits that can be derived during the migration
process, which in turn maximises the value obtained

Service Features Service Benefits

» Migration candidate identification, strategy, Reduced operational costs
planning and roadmap development Reduced migration costs

» Business service and technical solution Exploratory service prior to design and
delivery implementation

vVVvyy

» Specialists in AWS and Azure Migration » Greater benefits realisation

» Data cleaning and transformation » Improved service quality

» Cloud and Data Centre optimisation and » Increased flexibility
migration » Focus on user needs

» General purpose office application » Improved delivery using a variety of
migration to Cloud Saa$S menthodologies

» Hybrid deployments of general purpose » GDS Technology Code of Practice and
office applications Cloud First Strategy knowledge

» Specialists in Google Apps and Microsoft » Smooth transition

Office 365 migrations

» Data, Application and service migration to
SaaS offerings

» Bespoke application transformation and
migration

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



28. Digital Print Services

M4 deliver Cloud based infrastructure services for print. Providing P
expertise to deploy cloud based infrastructure, M4 specialise in DIGITAL GROUP
transforming on premise hosted solutions to cloud based print queue

and server management solutions by aligning print and hosted/virtual
infrastructure, leading to increased efficiencies and measurable cost

benefits
Service Features Service Benefits
» Infrastructure as a service » A clear understanding of what is required for
» Consumption based Cloud Services Discovery/Beta
» In-depth knowledge of open and GDS » Iterative Agile development allowing
standards incremental and rapid delivery
» Alignment to digital business strategy e.g. » Improved user experience
Hubs, Cloud » Embeds new ways of working with use of new
» Focus on risks, dependencies and integration technologies
to wider services » Encourages behavioural change to realise
» Experienced team capable of rapid deployment benefits
» Iterative prototype development ensuring » Bespoke, flexible ways of working to meet your
continuous improvement business needs
»  Expertise in all common OEM and Software » Validation of requirements, technical feasibility
vendor solutions and user needs

» Focus on the User Centric Design >
»  Testing - user, business and technical needs

M4 Digital Group- Combined Service Descriptions - G-Cloud 14

Encouraging stakeholder buy-in employing
visual design

Provides the ability to estimate costs
Improved cost efficiencies



29. Digital Print Services - Cloud /
Platform Enablement

M4 ensure that hardware solutions and user requirements are

assimilated into your infrastructure design. Understanding the potential DIGITAL GROUP
for Cloud based infrastructure, we produce scenario mapping for various

environments and ensure alignment with other aspects such as Security
& Identity standards, core user requirements and Service Deployment

plans.
Service Features Service Benefits
» Managed Print Services » Value for money through print on demand &
»  Print Infrastructure, network design and BYOD
implementation » Flexible service provision
» Infrastructure as a Service » Reduced risk and security assurance
» Digital Print Application and Software » User based design and experience
integration » Convenience, eliminate drivers, cables,
» User analytics software variance
» Scanning and digital workflow enablement » Reduced cost to install and maintain servers
» Authentication and follow your print solutions »  Sustainability through print on demand
» Single user interface and experience » Software update automation
»  Automation of software and policy updates »  Simplicity through cloud based single solution
»  Security assurance and ease of

software/service maintenance

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



30. Digital Print Services - Implementation /
Enablement

Our endpoint cloud transformation solution design reflects the security,
network and user environment as well as specific tailored requirements. DIGITAL GROUP

M4 design the print solution and/or the related infrastructure (hosting,
network) and assist in the project implementation with PMO services

Service Features Service Benefits

» Program and project management » Cost effective roll out

» Stakeholder engagement » Effective change management

» Change management » Risk assurance

» Governance, risk management and » Project phasing and benefit realisation
implementation milestone planning » Access to subject expertise

» Transition and roll out management » Clear stakeholder engagement

» User training and education » Single source of program management

» Vendor and client management and integrated » Adherence to time, budget and requirements
PMO » Integrated planning

»  Multi-discipline integration of IT, Facilities,
Vendor and User requirements

» Project phasing and benefit realisation

» POC and pre release management

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



31. Digital Print Services - Strategic
Sourcing

Experts in cloud enablement and strategic sourcing, M4 utilise material
gathered during the assessment phase to create artefacts and insights to
drive a tender/procurement process. Targeting increased efficiencies and
full economic benefit we assist with brief creation, scope parameters,
expectations, and data/financial criteria, to ensure integrity of vendor

b

DIGITAL GROUP

selection.
Service Features Service Benefits
> RF_P prep.aratior.\ _ _ » Level playing field
»  Print policy design (business requirements) » Best market selection (execution and
» User interface and experience design (user innovation)
requi-r_eme-nts) _ » Best value selection
»  Specification and scope of device layer »  Clarity of scope, approach and selection
»  Specification and scope of software layer requirements
» Specification and scope of infrastructure layer » Detailed design to minimise scope and project
» SLA and strategic relationship and supplier creep
management design » Benefit realisation
» Assessment and success criteria design and » Implementation risk reduction
evaluation » Clarity of SLA's, commercial approach,
» Tender review, down selection and selection charging mechanism
process expertise »  Clarity of cost levers and future transformation

» Contract and commercial expertise

M4 Digital Group- Combined Service Descriptions - G-Cloud 14

opportunities



32. Digital Transformation Service /

The complexity of digital transformation demands a strong digital
capability and an Agile data driven culture, if you are to capture the DIGITAL GROUP

value of a successful programme. M4 offers a mature and experienced
digital transformation service designed to focus on benefits-realisation
and accelerate the speed of your delivery.

Service Features Service Benefits
» Review of your technology, digital, business » Increase benefits realisation through
and delivery environment translation of business needs
»  Quickly identify transformation objectives » Rapid delivery of Cloud based digital platforms
» Gap analysis » Increase value and lifespan of legacy through
» Review existing and emerging Cloud Cloud integration
technologies and align to objectives » Knowledge transfer to internal staff
» Transform business processes and align to » M4 drive cultural change increasing cloud
strategic projects adoption rates
» Improve user experience » GDS technology Code of Practice and Cloud
» Identify new digital opportunities First Strategy knowledge
» Complete managed service delivered in an » Focus on user needs
Agile manner » Collaborative approach

» Increases reuse and consolidation of IT assets
and infrastructure

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



33. Discovery

b

DIGITAL GROUP

M4’s Discovery service allows organisations to kick-start projects by
gaining a thorough understanding of existing services and user needs.
Through Discovery we collaborate with clients to understand their
challenges and then assist to define approaches and solutions.

Our service definition focuses upon user needs, pre-deployed technology

and budgetary constraints.

Service Features

» Review of current IT operations and processes >
» Independent review of budgets and timescales >
» Independent review of market data and >
business trends >
» Document user needs via thorough research
» Task analysis >
» Analysis of existing technical systems,
capabilities and environment >
» Direct consultation with any existing services >
providers >
» Validate qualitative and quantitative evidence >

» Understand pre-existing constraints
» Timeboxed delivery, typically 4 - 12 weeks

M4 Digital Group- Combined Service Descriptions - G-Cloud 14

Service Benefits

Refine goals and strategy

Validate your need for a new digital service
Stakeholder engagement

Efficiently run and conducted workshops and

interviews

Commercially aware teams always looking for
economically advantageous solutions

Better results through collaborative approach
Improved levels of project delivery

No preconceived ideas about Alpha necessity
Prepare for Alpha with a clear scope of the
service




34. Exit and Transition - Requirements Delivery /

With ever evolving hardware/software/business needs, M4’s Business
and Systems Analysis team assist clients to create outcome based

requirements aligned to business needs and SLA/KPI’'s. We assist DIGITAL GROUP
with data analysis, cost/benefit analysis, systems review and

prioritisation of researched user needs geared towards aligning
technology with business strategy and commercial/market appetite.

Service Features Service Benefits
» Use Agile, Waterfall or Hybrid approach to » Experience in delivering in complex, high
deliver change performance operating environments
» Access to highly experienced senior Business » Improved service quality
Analysts providing thought leadership » Experienced in digital, Open Source and
» Gathering of service, functional, non- Cloud applications and services
functional and business requirements » Experienced in working collaboratively
» Requirements Management and change within multi-supplier teams
control » Innovative cloud solutions designed and
» User needs, backlog prioritisation and MVP assured
analysis » Advanced functionality and service
» Translation of business objectives into quality
effective technology solutions » Reduced costs
» Documentation of contract and commercial » Enablement - Transition of knowledge
requirements and skills to staff
» Prototyping/working solutions, Business » Deep strategic and technical knowledge
Process Modelling and design transitioning from legacy services
»  Proficient in gathering Discovery outputs for » Focus on service continuity and business
Alpha value throughout the process

» Scaled Agile project implementation

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



35. Exit and Transition — Vendor Migration /

M4 support organisations transitioning between suppliers and provide

expertise supporting supply chain transition/onboarding of new vendors.

We ensure alignment of supplier capabilities with business requirements, DIGITAL GROUP
promoting collaboration between service providers and increasing Value

for Money across client environment. M4’s collaborative approach is

specifically designed to complement an organisation’s internal capability.

Service Features Service Benefits
»  Support supply chain transition through Agile »  Flexible highly experienced supplier-
business change management independent resource to support your
» Establish parameters for change; rapid v. organisations needs
more measured approach » Remove blockers to organisational change
» Drive service continuity thinking and support » Run change in multiple parallel phases
delivery to meaningful/measurable SLA’s » Improve timescales to delivery
» Drive change with one team, one goal, one » Improve quality of supplier output
attitude » Develop a culture of continuous improvement
» Staff engagement and creation of collaborative » Develop an atmosphere of higher team morale
approaches to deliver knowledge » Increased cost control via skilled suppler
» Continuous review and application of learning negotiation
» Transforming employees into a “change » Increased levels of communication,
engine” collaboration and feedback
» Enable staff development introducing new » Deep strategic and technical knowledge
skills and capabilities transitioning from legacy services
» Putting service continuity and business value
first

»  Full enablement programme encouraging long
term change

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



36. Exit & Transition - Business
Transformation Support

Supporting businesses going through major change, creating new Target
Operating Model (TOM) and designing organisational strategies to cope
with digital transformation of legacy services and vendor engagement
our team deliver enablement to your organisation to handle the impact
of exiting legacy contracts and deliver efficient Cloud based transformed

b

DIGITAL GROUP

services.
Service Features Service Benefits

» Highly experienced team delivering early wins » Ensuring continuity of critical technology,
and cost savings suppliers, people, processes.

» Fast and efficient, tried, tested GDS alighed » Highly experienced team with real world
methodologies experience to achieve success

» Providing a structured, prioritised approach to » Our teams are all experienced Agile
Gap Analysis professionals focused on delivery

» Business impact and practical Risk Analysis » Clarity of resilience requirements to meet best
covering all solution elements practice standards compliance

» Focus on practical aspects of framework » Ensuring legacy service continuity during
alignment, policies, governance approvals supplier exit and transition

» Aligned to Crown Commercial services approval » Targeted training and awareness for critical
processes and IPA governance people and teams

» Real world expertise in delivering to central »  Supporting Crown Commercial approval
government guidance processes

» Understanding the criticality and practicality of » Experience in delivering in complex, high
Cloud provided Public Services performance operating environments

» encompassing User needs, early delivery, TUPE » Managing exiting and Onboarding of vendors to
impact, continuity of service meet business needs

» Track record of delivering technology service » Enablement - Transition of knowledge and skills

transition across Government

M4 Digital Group- Combined Service Descriptions - G-Cloud 14
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37. Exit & Transition — Internet Service Migration /
& Cloud Readiness Security Assessment

Assessing Security compliance to multiple standards in support of
readiness for business move to "Cloud First IT". Assessing all aspects
of your organisations alignment to the NCSC and central Government
recommended Security principals, identifying misalignments in
readiness and preparing a prioritised action plan supporting secure
migration to Cloud.

DIGITAL GROUP

Service Features

Utilising our Security assessment tooling to
deliver consistent results

Fast and efficient, tried and tested
methodology

Providing a structured, prioritised approach to
a Gap Analysis

Using Business impact and Risk Analysis
covering all solution elements

Focus on service continuity and business value
throughout the process

Integration of Cloud/legacy services within
Government and supplier resilience
programmes

Automated reporting system to map
compliance across multiple standards
Understanding the criticality and practicality of
Cloud provided Public Services

encompassing User needs, backlog
prioritisation and MVP analysis

Access to highly experienced senior Business
Analysts providing thought leadership

M4 Digital Group- Combined Service Descriptions - G-Cloud 14

Service Benefits

Ensure critical technology, suppliers, people,
processes and premises are compliant

Provides real world experience based priority
backlog to achieve compliance

Utilises highly experienced professional analysts
supported by our unique methodology

Clarity of resilience requirements to meet best
practice standards compliance

Ensuring legacy considerations as part of the
wider compliance picture

Targeted training and awareness for critical
people and teams

Supporting introduction of policies to deliver
compliance to multiple standards

Experience in delivering in complex, high
performance operating environments

Follow the GDS Lifecycle, Standards and
Manual

Enablement - Transition of knowledge and skills
to staff




38. Exit, Transition & Transformation; /
Lifecycle Support

M4 Digital support delivery of disaggregation / reprocurement / DlGITAL GROUP

novation of IT contracts and related services. Our teams flex capability
to meet project demands; coverage includes expertise in Business
Analysis, IT Architecture, IT Security Assurance, Service Management,
Project Management, Commercial negotiations and Procurement

activities.
Service Features Service Benefits

» Outcome based requirements documented in » Highly experienced team delivering early wins
ITIL compliant Service Register and cost savings

»  Provision of a structured, prioritised » Reusable commercial model for ongoing
approach to Gap/Risk Analysis management of service providers

» Contract Exit, Technical Assurance and » PMO, Project management, Business and
Service Transition Management Technical Analysis expertise

» Financial modelling/cost models to inform »  Clarity of resilience requirements complying
best options for delivery with best practice principals

» Real world expertise in working with PCR » Ensuring legacy considerations as part of the
2015 regulations wider compliance picture

» Integration of Cloud/legacy services within » Experience of working collaboratively with
Government and supplier resilience both internal and external partners
programmes »  Supporting introduction of policies to deliver

» Production of commercial and procurement compliance to multiple standards
documentation »  Strong track record of delivery to HM Gov

» Familiar with TUPE and its application during Public Sector
transition » Follow the GDS Lifecycle, Standards and

» Encompassing User needs, early delivery, Manual
backlog prioritisation and MVP analysis » Enablement - Transition of knowledge and

» Production of Business Cases aligned with skills to staff

HMT Green Book
M4 Digital Group- Combined Service Descriptions - G-Cloud 14



39. Exit & Transition; Migration of Services from
Private and PSN Networks to Internet, Cloud and FN4G /

Supporting secure migration of services to the Internet, Cloud and
FN4G from PSN, and other private networks. Ensuring compliance with DlGlTAL GROUP
security best practice and encompassing cost-benefit analysis of
practical solutions, prioritisation of MVP meeting User needs, utilising
design expertise and migration support from our highly experienced
technical and business team

Service Features Service Benefits

» Highly experienced team delivering early wins »  Ensure critical technology, suppliers, people,
and cost savings processes and premises are secure

» Fast and efficient, tried and tested » Provides real world experience based
methodologies and designs priority backlog to achieve compliance

»  Providing a structured, prioritised approach to »  Utilises highly experienced Agile
a Gap Analysis professionals focused on delivery

» Using Business impact and Risk Analysis »  Clarity of resilience requirements to meet
covering all solution elements best practice standards compliance

» Focus on service continuity and business » Ensuring legacy considerations as part of
value throughout the process the wider compliance picture

» Integration of Cloud/legacy services within » Targeted training and awareness for critical
Government and supplier resilience people and teams
programmes »  Supporting introduction of policies to deliver

» Real world expertise in delivering to central compliance to multiple standards
government guidance »  Experience in delivering in complex, high

» Deep strategic and technical knowledge performance operating environments
transitioning from legacy services » Follow the GDS Lifecycle, Standards and

» Encompassing User needs, backlog Manual
prioritisation and MVP analysis » Enablement - Transition of knowledge and

»  Access to highly experienced senior Business skills to staff

Analysts providing thought leadership

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



40. Exit & Transition — Security Framework /
Alignment Assessment & Support

Assessing Security compliance to multiple standards in support of readiness
for business move to "Cloud First IT". Assessing all aspects of your DIGITAL GROUP

organisations alignment to the NCSC and central Government recommended
Security principles, identifying misalignments in readiness and preparing a
prioritised action plan supporting secure migration to Cloud.

Service Features Service Benefits

»  Utilising our Security assessment tooling to . )
deliver consistent results »  Ensure critical technology, suppliers, people,

»  Fast and efficient, tried and tested processes and premises are compliant
methodology » Provides real world experience based

»  Providing a structured, prioritised approach priority backlog to achieve compliance
to a Gap Analysis »  Access to highly experienced CISSP certified

»  Using Business impact and Risk Analysis team members _
covering all solution elements »  Clarity of resilience requirements to meet

»  Focus on practical aspects of framework best practice standards compliance
alignment, policies, technical capability »  Ensuring legacy considerations as part of

» Integration of Cloud/legacy services within the wider compliance picture N
Government and supplier resilience » Targeted training and awareness for critical
programmes people and teams

»  Automated reporting system to map »  Supporting introduction of policies to deliver
compliance across multiple standards compliance to multiple standards

» Focus on service continuity and business »  Experience in delivering in complex, high
value throughout the process performance operating environments

» Encompassing User needs, backlog » Follow the GDS Lifecycle, Standards and
prioritisation and MVP analysis Manual N

»  Access to high level Business Analysts that »  Enablement - Transition of knowledge and
provide thought leadership skills to staff

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



41. Exit & Transition — Vendor Exit & Client /
Service Transition Support

Our highly experienced Vendor agnostic team deliver Client
enablement, and Intelligent Client services supplementing your in
house skills to ensure the smooth transition of services from
incumbent and legacy suppliers to Cloud. Working with and to Crown
Commercial guidelines we provide both technical and commercially
aware support and thought leadership

DIGITAL GROUP

Service Features
Highly experienced team delivering early wins
and cost savings
Fast and efficient, tried, tested GDS aligned
methodologies
Providing a structured, prioritised approach to
Gap Analysis
Business impact and practical Risk Analysis
covering all solution elements
Focus on practical aspects of framework
alignment, policies, governance approvals
Aligned to Crown Commercial services
approval processes and IPA governance
Focus on service continuity and business
value throughout the process
Provide technical, security and contractual
solutions, across your IT landscape
Encompassing User needs, early delivery,
backlog prioritisation and MVP analysis
Track record of delivering technology service
transition across Government

M4 Digital Group- Combined Service Descriptions - G-Cloud 14

Service Benefits

Ensuring continuity of critical technology,
suppliers, people, processes.

Highly experienced team with real world
experience to achieve success

Our teams are all experienced Agile
professionals focused on delivery

Clarity of resilience requirements to
meet best practice standards compliance
Ensuring legacy service continuity during
supplier exit and transition

Targeted training and awareness for
critical people and teams

Supporting Crown Commercial approval
processes

Experience in delivering in complex, high
performance operating environments
Managing exiting and Onboarding of
vendors to meet business needs
Enablement - Transition of knowledge
and skills to staff




42. PSTN Switchover /

M4 Digital support delivery of PSTN switchover programmes from initial
service identification and validation through solution evaluation &

selection, procurement, service transition and on to early life cycle DIGITAL GROUP

support
Service Features Service Benefits

» Controlled exit of PSTN/legacy services whilst » Real world experience of supporting PSTN
maintaining compliant safe operations switchover

» A digital switchover service with proven » Financial modelling/cost models to inform best
identification and assessment methodology options for delivery

» Tried and tested bespoke Transition / » Production of Business Cases aligned with HMT
Transformation / Migration planning Green Book

» ITIL service framework, outcome based » Proven commercial model to manage PSTN
requirements built into Service Register switchover

» Provision of a structured, prioritised approach » PMO, Project management, Business and
to Gap/Risk Analysis Technical Analysis expertise

» Security and risk assessment of new vendor » Experience of working collaboratively with both
solutions internal and external partners

» Business Process Change Management aligned » Technical Assurance and Service Transition
with PSTN switchover Management

» Identification of efficiency gains through » Strong track record of delivery across Public
removal of legacy services Sector

» Addresses health, well-being and alarm » Enablement - Transition of knowledge and
services e.g. Redcare skills to staff

» PCR 2015; compliant production of commercial
and procurement documentation

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



43, Exit from Legacy Core Services /

The M4 team holds all the current, hands-on technical and strategic

skills necessary to support the transformational journey away from

legacy Core Services. This service will de-risk the transition from legacy DIGITAL GROUP
systems to new solutions for Networks, Server Infrastructure, DNS, E-

mail relay and NTP; recognising that “The internet is ok”.

Service Features Service Benefits
»  Highly experienced agile team focused on » Supporting Central and Local Government
delivery »  Supporting introduction of policies to deliver
» Fast and efficient, tried and tested compliance to multiple standards
methodologies and designs » Experienced team delivering early wins and
» Real time expertise in exit from all Core measurable cost savings
Services » Use of Business Impact and Risk Analysis
» Deep strategic and technical knowledge of the covering all solution elements
underlying components »  Full compliance with GDS advice and guidance
» Real world expertise formulating GDS guidance »  Full compliance with Cabinet Office policies
»  Focus on practical aspects of framework »  Full compliance with NCSC advice and
alignment, policies, technical capability guidance
» Expertise in applying NCSC Cloud security
principles

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



44 . Functional Testing Service /

M4 provide cost effective Test Consultancy and Resource Services,

covering a comprehensive range of Quality Assurance and Software

Testing services. Specialists conduct Functional Testing using Waterfall, DlGlTAL GROUP
Agile and Lean methodologies with an appropriate level of testing

meeting programme delivery plans so as to ensure systems satisfy

user specifications and requirements

Service Features Service Benefits
. _ » Cost effective and Flexible Model
> Test execution including Test _ »  Specialist Functional Testing Expertise
Incident/defect Management and Reporting » Reducing delivery lead time by the provision of
» Manual and Automated Test Design, skilled specialists
Scripting and Execution »  Alignment with GDS design manual and NCSC

» Accessibility, Usability, SIT, UAT, Web, Security principles

Mobile and Compatibility Test Reducing project downtime

>  Project delivery Methodologies from Taking control of your solution quality
traditional Waterfall, V-Model to Quality control and process improvement
Agile/Scrum/hybrid approaches Knowledge transfer

» Cloud IaaS, PaaS, SaaS testing models Enablement

» Support ERP, packaged application, open Collaboration
source software
Quality and test driven development
Procurement and contract exit
Functional Testing using Waterfall, Agile and
Lean methodologies
» Consultants carry active Government
clearances - SC and Disclosure Scotland

vVVvVvVVyVyYVYY

vVVvyy
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Integration Service

This service provides for guidance and assurance to deploy, transform,
migrate to Google Cloud Technology. M4 team members will assist with DIGITAL GROUP

the development of an A-Z integration/transformation model that
importantly also addresses cultural change issues. Provides for the
build of scalable and elastic IT-enabled capabilities.

45. Google Cloud Platform Transition and M!

Service Features Service Benefits
» Experienced and knowledgeable DevOps, » Realisation of material cost savings
System Integration and Platform Architects » Accelerate delivery of ultimate business
» Bestin class Web Ops capabilities outcomes
» Strong focus on principles of Cloud » M4 drive cultural change increasing cloud
Security adoption rates
» Provides for continuous delivery » Higher level of business user satisfaction;
» Experienced assistance with IaaS, PaaS, distributed budget spend
BaaS & SaaSs solutions selection » Improve levels of virtualisation,
» Provides for Agile development standardisation and automation
» Scalable, elastic solution »  Optimise maximum agility
» Enable innovation via continuous delivery »  Efficient adoption and transition
of new service capabilities » Solid Google platform design
» Provides for automated test and design » Focus on service continuity and business

» Maximise benefits of increased value throughout the process

functionality and security features Deep strategic and technical knowledge
transitioning from legacy services

v
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46. Identity Assurance and Access /
Management

M4’s Identity Assurance and Access Management (IdAM) service address
the security discipline that offers authorised individuals access rights to DlGlTAL GROUP
information across increasingly complex technology environments. With
identity and access policies becoming ever more crucial M4's
experienced team assist with the design and adoption of IDaaS and
cloud IdAM solutions

Service Features Service Benefits

» Expert knowledge of meeting security »  Clarification of Identity Assurance & Access
standards and tooling for Cloud Management needs

» Identification and analysis of business » Implement cost-effective and efficient risk
processes with an IdAM requirement management

» Identification and analysis of business » Define and implement identity policy in
processes with bespoke Identity line with Government standards
requirements » Design a bespoke, appropriate identity and

» Identification of business process access strategy
utilising GOV.UK Verify »  Establish policies for privileged accounts

» Identification of the most appropriate »  Solutions aligned to NCSC Security
Access Management products and principles
tools » Ensuring access is both convenient and

» Full identity lifecycle management secure

» Identity and access policies and » Establishing confidence in customer
solutions for your Cloud infrastructure privacy and data security

» Flexible authentication methods » Designs incorporating users in mind,

» IdAM strategy and implementation focused on speed and accuracy

aligned to latest Government policy
» Focus on service continuity and
business value throughout the process

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



47. Information Security Service /

Information and Security Services help to provide and assure your
secure digital services and capabilities. M4 work across both software DlGlTAL GROUP
and hardware domains and deploy CLAS certified consultants and
HMG security classification aware resources.

Service Features Service Benefits

»  Audit, Compliance review of policies, Maintain service continuity across Cloud,
processes, systems and data PAAS, SAAS, and legacy infrastructure

» Strategy, Standards, Policy and Delivery Flexible service tailored to your user needs
of effective, secure digital services UK Government Sector experience

» Business Continuity Planning and Health Improved service Quality
Checks Experience in delivering in complex, high

» Classification, IL2, IL3, CLAS, Public performance operating environments

v
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Service Network (PSN), GSI. » Transition of knowledge and skills to staff
» Data Centre, Firewalls, Encryption, »  Working Collaboratively and delivering to
Infrastructure, End Point, Network, NCSC Security principles
Application security _ » Understanding risks to Data Assets
» Digital, cloud, IaaS, Hybrid » Follow the GDS Lifecycle, Standards and
» Information Security Strategy Guidance Manual
»  Security Penetration Testing and » Focus on service continuity and business
remediation of security items and issues value throughout the process

» Policy Design

» Design and implementation of
vulnerability reporting and remediation
systems

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



48. IT and Cloud Transformation /
Assessment and Capability

M4 provide Procurement, Integration and Cloud Migration expertise. All
of our team members have a wealth of experience, within the public
and private sector, with cross-functional/industry expertise to support
internal resources delivering assessments and enhancing capability to
inform and transform Cloud Transitional and deliver Target Operating

DIGITAL GROUP

Model transitions.

Service Features

» Collaborative assessment of capability to deliver
future Cloud business needs

» Enhancement of internal capability to transform to
GDS practices

» Provide project cost and benefits estimation, and
delivery planning

» Provide Cloud relevant Enterprise, Data, Solution,
Technical Architecture capability planning

» Align solutions to GDS desigh and NCSC Cloud
security principles

» Deliver service transition capability from legacy
data centre to Cloud

» Deliver capability across Cloud, Digital, ERP and
legacy transformations

» Provide technical, security and contractual
reviews, across your IT landscape

» Provide follow up development, prototyping,
testing, skills transfer, management enablement

» Focus on service continuity and business value
throughout the process

M4 Digital Group- Combined Service Descriptions - G-Cloud 14

Service Benefits

Improve communication and planning,
translate business needs to technical plans
Reduces costs and delivery timelines
identifies benefits fiscal and technical
Using technological change to maintain
and deliver improved secure services
Alignment to GDS Technology Code of
Practice

Increases reuse and consolidation of IT
assets and infrastructure

Implementing Government Cloud security
principles on legacy and transitional
environments

Deliver secure hybrid solutions and
roadmap to full Cloud migration

Focus on maintaining and increasing
system security through transition
Collaborative enablement, knowledge
sharing and skills transfer to internal staff
Enable migration from old legacy systems
to cloud enabled services




49, IT Enabled Business Transformation /

Employing a collaborative approach via stakeholder engagement,
delivery of quick wins, documented transformation planning and

enablement programmes designed to support new ways of working, DIGITAL GROUP
M4 team members have a wealth of experience in delivering positive

outcomes to Cloud transition and Change. With focus on maintaining
service continuity and business value.

Service Features Service Benefits
» Manages transformation with different » Stakeholder engaement and management across
technologies in different environments the organisation
» Employs various, industry standard » Seamless transition
methodologies and hybrid approaches » Embeds new ways of working with use new
» Embeds cultural and behavioural change technologies
within organisations » Encourages behavioural change to realise
» Provides a consistent and coherent benefits
approach to transformation » Improved structure and operating model
» Custom transformation aligned to overall » Services aligned to user needs
organisational strategy and goals » Bespoke, flexible ways of working to meet your
» Transformation assessment of people and needs
process » Manage and reduce complexity
» Identify further opportunities for digital » Enablement - skills and knowledge transfer
transformation » Enables greater workforce efficiency

» Realise and unlock the benefits of digital
technology investment
» Provide technical, security and contractual
reviews, across your IT landscape
» End to end business transformation
M4 Digital Group- Combined Service Descriptions - G-Cloud 14




50. IT Strategy and Architecture /

Providing end-to-end support, from collaborative thought leadership in

the boardroom, defining IT roadmaps, leveraging our knowledge of the

supply chain as a critical friend in negotiations. Delivering high and DIGITAL GROUP
low level tried and tested architectural designs aligned to real-world

needs and meeting the technology code of practice.

Service Features Service Benefits
_ _ _ _ _ _ _ » Identify and leverage existing Client skills,
» Leveraging wide hybrid skill set in Prince, Agile, uplifting and supporting collaboratively
TOGAF, ITIL »  Supplier neutral, well versed in negotiations
»  Public/private partnership strategic technical » GDS, IPA, UK, Scots Government experience
and commercial and legal support expertise large and small agencies
»  Skilled Auditors of existing and future multi- »  Contributors to Government Technology Code of
supplier landscape Practice
»  Multi-disciplinary teams, highly skilled in » Innovators of cost benefit based transformational
commercial/technical negotiations and design transitional change
>  Proven iterative delivery mthods form!ng »  Catalyst to innovation, finding solutions
detailed roadmaps from outline strategies » Deliver Government aligned, proven high and low
» Proven technical architecture models, MVP level architecture designs
driven cost benefit based delivery » Re-engineering current designs to shorten
» Detailed Operating Model delivery meeting transition
Government TOM guidance »  Focus on service continuity and business value
» TUPE aware commercial, strategic technical throughout the process
support during transition and transformation »  Critical friends focused on transition of skills and
» Stakeholder engagement at all levels from CIO knowledge support

to vendor architect
» Follows UK Government Technology Code of
Practice and Transformation Strategy

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



51. Legacy Infrastructure Path to Cloud /
Migration

M4 project teams include Systems Architects, Systems Administrators,
Planning Managers, Analysts, Technical Architects, and SIAM Cloud DIGITAL GROUP

professionals. All specialists have a wealth of experience migrating to
Cloud within the public and private sector and aim to deliver
innovative solutions to real-world blockers to Cloud Migration.

Service Features Service Benefits

» Define and update your Cloud transition strategy, » Improve communication and planning, translate
and roadmap documentation business needs to technical plans

» Deliver secure Cloud infrastructure integration » Reduces costs and delivery timelines identifies
planning and administration benefits fiscal and technical

»  Provide project cost and benefits estimation, and » Increased speed to deliver using tried and tested
delivery planning methods

»  Provide Enterprise, Data, Solution, Technical » Alignment to GDS Lifecycle and Design Manual
Architecture using SAFe » Increases reuse and consolidation of IT assets

»  Align system solutions to GDS design standards and infrastructure
and Service Manual » Increases digitisation and Cloud take-up

»  Deliver solutions across transitional » Deliver real world hybrid solutions on track to full
Infrastructure, virtualisation, data centre, Cloud
network, Cloud »  Focus on gaining benefit from transition to Cloud

» Deliver solutions across Cloud, digital, ERP and » "Knowledge transfer to internal staff,
legacy replacement enablement, collaboration"

» Provide technical, security and contractual
reviews, across your IT landscape

»  Support procurement, contract, product, vendor
and supplier exit, transition, testing

»  Provide follow up development, prototyping,
testing skills transfer and management

M4 Digital Group- Combined Service Descriptions - G-Cloud 14




52. Microsoft Cloud Services /

M4 specialises in Cloud-based Microsoft Office 365 services and delivers

solutions for web content management (WCM) and electronic document

and records management (EDRM). With many team members being DIGITAL GROUP
certified solution architects and having a deep working understanding

of Microsoft products, M4 can deliver client projects using Microsoft

technologies

Service Features Service Benefits
» Manage data growth, ensuring security and » Facilitate easy and secure access to data
compliance » Improved Business Intelligence
» Optimise spend, maximise cloud potential » Improved monitoring of applications and
» Delivering the ability to work from multiple infrastructure
locations » Fast, powerful search engine
» Analyse Big Data and make informed » Facilitate simple and secure access to
decisions corporate information
» Secure Cloud based platform » Office 365 integration
» Scalable infrastructure » Flexible work and document collaboration, from
» Rapid depoloyment of Sharepoint servers anywhere
» Risk management of content and » Increased workforce efficiency
documentation » Protect data and applications with back up and
» Integration of PowerBI archive solutions
» Maintain service continuity and business » Provide technical, security and contractual
value throughout the process reviews, across your IT landscape

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



53. Microsoft Office 365 Integration and /
Cloud Migration Service

M4 provide migration and integration services to Microsoft's 0365 SaaS
offerings. We provide a flexible set of migration and integration DIGITAL GROUP

approaches enabling the preparation and delivery of blended on-
premise and Cloud-based SaaS services, whilst ensuring compliance
with government secure email blueprint and government user access
control requirements.

Service Features Service Benefits

Reduced operational costs
Reduced integration and migration costs

» Microsoft Exchange email, calendar
and contact migration and integration
»  Microsoft SharePoint migration and Smooth transition
Enterprise Mobility Suites integration Flexible delivery roadmaps, integration and
» Identity integration and migration, migration approaches

vVVvVvVvyy

normalisation and transformation » Improved service quality
»  Utilisation value proposition exploration »  Exploration of additional business benefits
» Data cleaning and transformation derivable from the investment
»  Migration strategy, planning and » Government compliant service and solution
roadmap development »  Government blueprint and security

» Hybrid technical and service process
development and governance

» Architectural and security design
services

» Mentoring and skills transference

» Bespoke application transformation and
Cloud migration

requirements alignment
» Focus on user needs and service continuity
Alignment to GDS lifecycle and Cloud First
Strategy

v
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54. Microsoft System Centre Assessment
Services /

This M4 service offers you assurance that your Microsoft System
Center (SCCM, SCOM, SCSM, SCVMM, SCDPM, SCORCH) environment

is configured to current industry best practice. A M4 experienced
Systems Management Consultant will produce a Management Report
that details recommendations to improve performance and reliability.

vVVvyy

v
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Service Features

Enforcing and reporting of
configuration management and
infrastructure stability

Current System Assessments
Complete system design and build
System Center Configuration Manager
(SCCM)

System Center Operations Manager
(SCOM)

Systems Center Service Manager
(SCSM)

Management report
Recommendations

Workshops and pilots

Provide technical, security and
contractual reviews, across System
Centre landscape

VVVYVYYVYY

vVvVvyy

Service Benefits

Systems Assessment

Configuration Recommendations
Quality of Delivery

Efficient working through automation
Cost savings

Increased responsiveness and service
efficiencies

Accelerated deployment

Knowledge transfer

Enablement

Collaboration

DIGITAL GROUP



55. Migrate away from Legacy to Cloud /
DNS

The M4 team holds all the current, hands-on technical and strategic
skills necessary to support the journey away from legacy Core DIGITAL GROUP

Services. This service will de-risk the transition from legacy DNS
Services to new GDS-compliant solution for Internet-based DNS
following NCSC guidance.

Service Features Service Benefits
» Highly experienced agile team focused on » Supporting Central and Local Government
delivery »  Supporting introduction of policies to deliver
» Fast and efficient, tried and tested compliance to multiple standards
methodologies and designs » Experienced team delivering early wins and
» Real time expertise in Exit from all Core measurable cost savings
Services » Use of Business Impact/Risk Analysis covering
» Deep strategic and technical knowledge of all solution elements
Legacy and Cloud DNS »  Full compliance with GDS advice and guidance
» Focus on practical aspects of framework »  Full compliance with Cabinet Office policies
alignment, policies, technical capability »  Full compliance with NCSC advice and
» Maintain service continuity and business guidance
value throughout the process » Expertise in applying NCSC Cloud security
» Provision of supplier contract technical principles

and security assurance

» Provide technical, security and contractual
reviews, across your IT landscape

» Deep technical knowledge of securing
DNS to NCSC guidelines

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



56. Migrate away from Legacy Core /
Services to Alternative NTP Service

The M4 team holds all the current, hands-on technical and strategic DIGITAL GROUP
skills necessary to support the journey away from legacy Core Services.

This service will de-risk the transition from legacy NTP Services to more

secure services following NCSC guidance.

Service Features Service Benefits
» Highly experienced agile team focused on »  Supporting Central and Local Government
delivery »  Supporting introduction of policies to deliver
» Fast and efficient, tried and tested compliance to multiple standards
methodologies and designs » Experienced team delivering early wins and
» Real time expertise in Exit from all Core measurable cost savings
Services » Use of Business Impact and Risk Analysis
» Deep strategic and technical knowledge covering all solution elements
of NTP »  Full compliance with GDS advice and guidance
» Focus on practical aspects of framework »  Full compliance with Cabinet Office policies
alignment, policies, technical capability »  Full compliance with NCSC advice and
» Maintain service continuity and business gwdan_ce _ _ _
value throughout the process > Ex_pe!'tlse in applying NCSC Cloud security
» Provision of supplier contract technical principles

and security assurance

» Provide technical, security and
contractual reviews, across your IT
landscape

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



57. Migrate Legacy Email to the Cloud

MY,

DIGITAL GROUP

The M4 team holds all the current, hands-on technical and strategic
skills necessary to support the journey away from legacy Core
Services. This service will de-risk the transition from legacy Mail Relay
services to cloud-based mail services, following central government
guidance on moving away from gsi and other on-premises email.

» Highly experienced agile team focused on » Supporting Central and Local Government
delivery »  Supporting introduction of policies to deliver
» Fast and efficient, tried and tested compliance to multiple standards
methodologies and designs » Experienced team delivering early wins and
» Real time expertise in Exit from all Core measurable cost savings
Services » Use of Business Impact/Risk Analysis covering all
» Deep strategic and technical knowledge of solution elements
Legacy Email Relay services »  Full compliance with GDS advice and guidance
» Real time expertise supporting customers »  Full compliance with Cabinet Office policies
with GSI/family migration »  Full compliance with NCSC advice and guidance
» Up to date expertise migrating away from » Provide technical, security and contractual reviews,
GSI-family domains across your IT landscape
» Focus on practical aspects of framework
alignment, policies, technical capability
» Maintain service continuity and business
value throughout the process
» Maintain service continuity across Cloud,
PAAS, SAAS, and legacy infrastructure
» Provision of supplier contract technical and

M4 Digital Group- Combined Service Descriptions - G-Cloud 14

Service Features

security assurance

Service Benefits




58. Monitoring and Alert Management
Service /

M4 Datacentre Operations with a monitoring platform based on Microsoft’s
System Center Operations Manager (SCOM). A range of designs and

configuration options cater for on-premise or cloud implementations DIGITAL GROUP
capable of managing most datacentre elements, including line of business
applications, servers, hypervisors, storage and networking.

Service Features Service Benefits

»  Custom Monitoring and Alert solutions » Continual service improvement
including integrations with other solutions » Configuration recommendations

» Manage a broad range of Microsoft and » Reduced risk of unplanned downtime
Non Microsoft products » Increased quality of delivery

» Web based reporting and dashboards » Integrated Management Suite

» Planning Workshops » Guidance on industry best practice

» Technical design » System improvement plans

» Current state assessments » Knowledge transfer

» Reporting and recommendations » Enablement

» Skills and Knowledge transfer » Collaboration

» High level and low level design

» vulnerability reporting and patch

management

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



59. Network and Systems Health
Monitoring Service /

This service covers an array of vendor solutions, such as SolarWinds,

Splunk, Elk and SCOM. As an example for Microsoft, this service includes

design/implementation of Microsoft System Center Operations Manager DIGITAL GROUP
(SCOM) to streamline operations/ service management processes and offers

access to the full Microsoft System Center suite of products;

Service Features Service Benefits

» Cloud//Datacentre Management, through
monitoring, automation, reporting, configuration,
backups

» Infrastructure deployments and maintenance,
vulnerability reporting and patch management

»  Private and public clouds, enforcing/reporting of
configuration management/infrastructure stability

» System Centre 2012, 2016, 2019 & 2022

»  Microsoft System Centre Components inc
(SCCM/ECM/SCOM/SCVMM/SCORCH/ORCHESTRAT
OR/SCSM/SCA/SCDPM/SCEP)

» Also includes Virtual Machine Manager, Service
Manager, Applications controller,

» High Level/Low Level Design

» Agile project management, configuration,
development, testing, deployment, supporting
documentation

» Dashboard/report development utilising various
programming languages C#, ASP.net, PowerBI

» Integration with external systems e.g. ticketing

Continual service improvement
Configuration recommendations
Reduced risk of unplanned downtime
Increased quality of delivery
Integrated Management Suite

SC and NPPV Cleared Resources
Skills and Knowledge transfer
Enablement

Collaboration

Provide technical, security and
contractual reviews, across your IT
landscape

VVVVVVVVYVYVYY
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60. Opensource Cloud Computing /
Database Migration

"Open Source database technologies are technically competitive and cost
effective alternatives to proprietary technologies. M4's services for Cloud DIGITAL GROU P

migration modernise applications whilst minimising risk and reducing
TCO. Our Database Administrators and Architects teams specialise in
performance, back up recovery, support and security in Opensource
Cloud environments."

Service Features Service Benefits

» Audit of legacy technologies » Reduced operational costs
» Feasibility study of migration to the cloud » Reduced migration costs
» Migration plan with risk assessment » Advanced functionality and service quality
» Technology selection » Reduced vendor lock in
»  Cloud computing data migration » Improved design and documentation
» Application reconfiguration and development » GDS technology code of practice and Cloud
» Regression testing First Strategy knowledge
» Cloud optimisation service » Managed service delivery
»  Flexibility and scalability to user and system
growth
» Collaboration

» Knowledge transfer and enablement

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



61. Penetration Testing Services /

M4's technical security practice, provides Digital Security services including
Penetration Testing and Digital Forensics; a key practice that, via health

check review, pinpoints real world risks to business assets. We also provide DIGITAL GROUP
cloud service assurance as part of Cyber Essentials, PCI-DSS Compliance
and ITHC activities for ongoing assurance and accreditation

Service Features Service Benefits
» In-depth assessment of Infrastructure » Trusted security specialists cleared
Configuration, Web and Cloud-Based through National Security Vetting
Applications » Vulnerability remediation plans
» IT Health Check ITHC and wider » Enhanced Assurance of Systems and
Penetration Testing Services
» Reproducible steps to validate and » Expertise from experience across all
replicate identified vulnerabilities Industry Sectors
» Vulnerability Assessments » Risk ratings based upon threat, impact,
» Common Vulnerabilities assessment and ease of exploitation
Exposures (CVE) information » Enhanced threat understanding by working
» Cyber Essentials and Cyber Essentials Plus closely with Client Teams
Assessments and remediation undertaken » Penetration Test Management
» Internal or External, Black-Box or White- » Exposes vulnerabilities prior to
Box security testing approaches compromise
» Security architecture review, assurance » Enables proactive risk management
and remediation » Provide technical, security and contractual
»  Security build and configuration review reviews, across your IT landscape

» End point vulnerability monitoring and
rectification

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



62. PMO and Project Management

M4 PMO and PM teams help customers embrace technology P
investments through empowering end-users while maximizing financial DIGITAL GROUP
returns and business potential. We understand customer challenges and

offer core focus to deliver portfolios of work on time and to budget. We
lead strategic initiatives and deliver positive results for stakeholders.

Service Features

» Employing various, industry standard >
methodologies and hybrid approaches
» Cloud project implementation and >
deployment
» Supports Discovery, Alpha, Beta and Live >
» Assistance with exit from large
commercial contracts and suppliers >
» Commercial, application, Cloud, ERP, >
development, digital management and >
transformation
» Risk management, reporting, planning, >
budgeting, and finance management >
» Use best practice collaboration tools: Jira,
Confluence, Slack, HipChat etc. >
» Stakeholder and supplier management, >

ensuring deliverables are achieved

» Project Assurance and Quality
Management

» Provide technical, security and contractual
reviews, across your IT landscape

M4 Digital Group- Combined Service Descriptions - G-Cloud 14

Service Benefits

Flexible and bespoke managed service to meet
user needs

Break down complex problems into
manageable deliverables

Full consideration of risks, dependencies,
security and business change

Improved service quality

Extensive UK Government experience
Adherence to GDS Lifecycle, Standards and
Manual

Enablement - knowledge and skills transfer
Experienced in working collaboratively within
multi supplier teams

Drive project delivery

Draws on wider M4 expertise and communities
of interest



63. Quality Testing for Cloud Deployment /
Service I_

From Agile, automation, performance, usability and manual testing

through to entire transition to Cloud solutions, our Managed Service DIGITAL GROUP
provides a testing service giving you the flexibility you need whether it
be digital or traditional. Our test teams work at client request with both
Prince2 and Agile SCRUM processes.

Service Features Service Benefits

» Defining and managing testing processes

» User Acceptance Testing (UAT)

» Integration, System, Performance, Security
and technical testing

» Programme and Project management with
Prince2 or Agile processes

» Cloud IaaS, PaaS, SaaS testing models

» Support ERP, packaged application, open
source software

» Quality and test driven development

» Procurement and contract exit

» Provision of supplier contract technical and
security assurance

» Provide technical, security and contractual
reviews, across your IT landscape

Reducing service costs

Increasing flexibility

Reducing delivery lead time

Alignment with GDS design manual
Reducing project downtime

Taking control of your solution quality
Quality control and process improvement
Knowledge transfer

Enablement

Collaboration

VVVVVVVYYVYYVYY
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to Cloud

M4 provide teams of specialist Systems Developers, Systems
Administrators, Planning Managers, Analysts, Technical Architects and

Security Professionals. All our specialists have a wealth of experience, DIGITAL GROUP
within public and private sector, with cross-domain, cross-
functional/industry expertise furthering delivery of innovative
solutions to real-world blockers to Cloud Migration.

64. Secure Migration of Legacy Systems M{

Service Features Service Benefits
> Define secure interim Cloud transition » Improve communication and planning, translate
environments and migration strategy business needs to technical plans
> Secure systems integration, interim > Reduces costs and delivery timelines identifies
infrastructure development and integration benefits fiscal and technical
planning > Using technological change to maintain and
> Provide project cost and benefits deliver improved secure services
estimation, and delivery planning » Alignment to GDS Lifecycle and Technology
> Provide Enterprise, Data, Solution, Code of Practice
Technical Architecture using SAFe » Increases reuse and consolidation of IT assets
»  Align system solutions to GDS design and infrastructure
standards and manual » Implementing Government Cloud security
»  Deliver solutions across transitional principles on legacy and transitional
infrastructure, virtualisation, data centre, environments
network, Cloud > Deliver secure hybrid solutions and roadmap to
> Maintain service continuity across Cloud, full Cloud migration
IaaS, PaaS, SaaS, and legacy »  Focus on maintaining and increasing system
»  Provide technical, security and contractual security through transition
reviews, across your IT landscape »  Collaborative enablement and skills transfer to
»  Support procurement, contract, product, internal staff
vendor and supplier exit, transition, testing »  Enable migration from old legacy systems to
> Provide follow up development, Cloud enabled services
prototyping, testing, skills transfer and
management
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65. Secure Transitional Architectural
Design, Delivery and Migration to Cloud

M4 specialist project teams consist of Systems Administrators, Planning
Managers, Analysts, Technical Architects and Security Professionals. All
team members have a wealth of experience, within public and private
sector, with cross domain, cross functional and cross industry expertise
and deliver innovative transitional solutions to Cloud Migration.

b

DIGITAL GROUP

Service Features

» Define secure interim transition environments >
and migration strategy

»  Secure systems integration, interim >
infrastructure development and integration benefits fiscal and technical
planning >

» Provide project cost and benefits estimation,
and delivery planning >

» Provide Enterprise, Data, Solution, Technical Cloud enabled services
Architecture using SAFe >

»  Align system solutions to GDS design and infrastructure
standards and manual >

» Delivery of transitional Infrastructure; data
centre, crown hosting virtualisation, Cloud

» Deliver solutions across Cloud, Digital, ERP >
and legacy replacement full Cloud migration
» Provide reviews and audits across your IT >
landscape security through transition
»  Support procurement, contract, product, >
vendor and supplier exit, transition, testing security assurance
» Provide follow up development, prototyping, >

testing, skills transfer and management

M4 Digital Group- Combined Service Descriptions - G-Cloud 14

Service Benefits
Improve communication and planning, translate
business needs to technical plans
Reduces costs and delivery timelines identifies

Using technological change to maintain and
deliver improved secure services

Enable migration from old legacy systems to
Increases reuse and consolidation of IT assets
Implementing Government Cloud security
principles on legacy and transitional
environments

Deliver secure hybrid solutions and roadmap to
Focus on maintaining and increasing system

Provision of supplier contract technical and

Maintain service continuity and business value
throughout the process



66. SIAM Support Service /

M4 support organisations implementing internal SIAM service. We

provide expertise to develop/maintain an internal service supporting

supply chain disaggregation, promote collaboration amongst service DIGITAL GROUP
providers and increasing Value for Money across the supply chain.

We deliver an informed and tailored approach specifically designed to

fill gaps in an organisation’s internal capability.

Service Features Service Benefits

»  Support supply chain disaggregation/new supplier »  Supplier/partner with multi organisation experience

onboarding through Agile change management (Private & public sector)

»  Establish clearly defined change parameters »  Proactive removal of blockers to organisational
enabling rapid, more measured approach change

»  Drive service continuity thinking and support » Run change in multiple parallel/phases with
delivery of meaningful/measurable SLA's consideration to appropriate risk

» Drive change with one team, one goal, service » Pragmatic approach to improve timescales to delivery
integration leadership » Ensure supplier output meets/improves upon

» Collaborative delivery of knowledge necessary quality and output
transfer/required outcomes to staff/supply chain ~ »  Develop a culture of continuous improvement and

» Continuous review and application of learning learning from experience

» Transforming employees into a forward thinking » Develop atmosphere of higher team morale through
proactive “change engine” positive engagement/clear communication

» Enable staff development via » Improved cost control via skilled supplier
introducing/transition of new skills and capabilities negotiations using commercial/technical experience

»  Puts business value first, instilling service » Supplier independent service ensuring no bias
guardian approach » Increased levels of communication, collaboration and

» Full enablement programme encouraging long feedback

term change
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67. Software Quality and Testing Service /

Software testing and Quality Assurance services to improve the quality
of IT services, reduce downtime and ensure performance and scalability.

UAT, technical, Integration, automation, performance testing, end to DIGITAL GROUP
end, environment and data management. M4 work using either Test
Driven Agile or traditional V-Model waterfall methods.

Service Features Service Benefits
: » Improved service quality
» Developing test strategy, standards and » Reduced delivery costs
pollc;les _ _ _ » Experience in delivering in complex, high
» Audit, review, risk and issue management performance operating environments
» Bug and Defect Tracking and resolution » Transition of knowledge and skills
» Agile test driven development approach »  Work collaboratively
» Managing test environments, tooling and » Collaboration
data _ o » Follow the GDS Lifecycle, Standards and
» Test integration across Digital, Cloud, ERP, Manual

Legacy, Packaged Applications

» User Acceptance Testing (UAT),
Penetration, Automation and Performance
Testing

» Test delivery using Prince2, Agile or hybrid
approaches

» GDS Service Standards, Design Manual

» Open Source and commercial tools

UK Government Sector experience
Flexible service tailored to user needs

\ A 4
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68. Solution Architecture, Design and
Delivery

M4 employ best practice to develop light-weight Agile processes for
programme oversight and guidance. The objective is to provide through
design, build, test and deliver phases, a repeatable methodology for
implementing solutions delivery while incorporating the flexibility
needed to adapt to specific customer needs.

b

DIGITAL GROUP

Service Features

» M4 provide solutions for public, private, » Cloud solutions aligned to business strategy
transitional, and hybrid Cloud » Benefits realisation through re-useable services

» Experienced in use of Crown Hosting, » Elasticsearch, Kibana, MongoDB, DynamoDB,
AWS, Azure and Google MySQL

» Iterative Agile development allowing » API Development, SOA, Microservices, RESTful,

Service Benefits

incremental and rapid delivery Web services

» Identification of efficiencies and savings » Flexible and bespoke cloud architecture

» Integration with your wider architecture solutions
reducing complexity » Reduced infrastructure costs and risks

»  Full solution architecture documentation »  Structured knowledge transfer process
and ERP systems integration » Improved user experience

» Expertise aligned with best practice » Adherence to GDS Lifecycle, Standards and
architecture standards/frameworks Manual

» Secure, resilient and scalable cloud » Provision of supplier contract technical and

platforms and transition solutions
» CI and CD approaches established
» Process and design based on user need

security assurance

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



69. Supply Chain Disaggregation Support /

M4 support organisations replacing monolithic single supplier IT delivery with a
disaggregated approach. We enable internal supply chain technical/commercial
management, promote collaboration amongst service providers and increase
Value for Money across supply chain. We deliver an informed and tailored
approach specifically designed to fill gaps in an organisation’s internal
capability.

DIGITAL GROUP

Service Features

Support supply chain disaggregation through
Agile change management

Establish parameters for change; rapid v.
more measured approach

Ensure service continuity thinking with
meaningful and measurable SLA’s

Develop a ‘one team - one goal’ attitude to
change

Collaborative engagement with staff to
ensure knowledge transfer

Continuous review and application of learning
Transforming employees into a long term
“change engine”

Drive staff development introducing new
skills and capabilities

Focuses on driving business value and
maintaining service continuity

Full enablement programme encouraging
long term change

M4 Digital Group- Combined Service Descriptions - G-Cloud 14

Service Benefits

Value of experienced supplier/partner
Highly experienced supplier independent resource
flexibly supporting your organisations needs
Removes blockers to organisational change
Enables change in multiple parallel phases for
timely delivery

Clarifies and improves delivery timescales against
clear milestones

Drives improved quality of supplier performance
and output

Develop a long term culture of continuous
improvement

Increased levels of communication, collaboration
and feedback

Increased cost control via skilled suppler
negotiation against industry benchmarks
Supplier independent service that removes
internal and external bias




70. Supply Chain Transformation Support M{

End to end support delivering everything from requirements definition,

through technical and commercial vendor negotiations. Delivering the

stand up and interim support of internal SIAM capability, driving vendor DIGITAL GROUP
collaboration during and after transition, M4’s service provides an

informed, supplier agnostic approach specifically designed to fill gaps in

an organisation’s capability.

Service Features Service Benefits
> Support supply chain transformation through »  Value of experienced supplier/partner
Agile business change management » Flexible supplier independent highly
» Establish parameters for change; rapid v. more experienced resource supporting your
me_asu!‘ed ap|:_>roach o organisations needs
» Maintain service continuity throughout, » Remove blockers to organisational change
delivering meaningful and measurable service » Run change in multiple parallel phases
levels » Improve timescales to delivery
» Drive change with one team, one goal attitude » Improve quality of supplier output
» Engagement with staff enabling collaborative » Develop a culture of continuous improvement
knovx_/Iedge dell\_/ery o _ » Develop an atmosphere of higher team morale
»  Continuous review and application of learning » Increased cost control via skilled suppler
» Transforming employees into a “change negotiations
engine” » Increased levels of communication,
» Enable staff development introducing new skills collaboration and feedback

and capabilities

» We put business value and service continuity
first

»  Full enablement programme encouraging long
term change

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



71. Supporting and Expanding Internal /
Migration Capabilities to Cloud

M4 teams provide specialist Systems Administrators, Planning managers,
Analysts, Technical Architects, and Security Cloud professionals all of
whom have a wealth of industry experience. With cross-domain, cross-
functional and cross-industry expertise we deliver pragmatic solutions to
real-world blockers to Cloud Migration.

DIGITAL GROUP

Service Features

Define Secure interim transition environments and
Cloud migration strategies

Secure systems integration, interim infrastructure
development and integration planning

Provide project cost and benefits estimation, and
delivery planning

Provide Enterprise, Data, Solution, Technical
Architecture using SAFe

Align system solutions to GDS design standards
and manual

Deliver solutions across transitional infrastructure,
virtualisation, data centre, network, Cloud

Deliver ERP solutions across cloud, Digital, and
legacy transition environments

Provide technical reviews and security audits
across your IT landscape

Support procurement, contract, product, vendor
and supplier exit, transition, testing

Provide follow up development, prototyping,
testing, skills transfer and management

M4 Digital Group- Combined Service Descriptions - G-Cloud 14

Service Benefits

Improve communication and planning, translate
business needs to technical plans

Reduces costs and delivery timelines, identifies
benefits fiscal and technical

Using technological change to maintain and
deliver improved secure services

Enable migration from old legacy systems to
Cloud enabled services

Increases reuse and consolidation of IT assets
and infrastructure

Implementing government Cloud security
principles on legacy and transitional
environments

Deliver secure hybrid solutions and roadmap to
full Cloud migration

Focus on maintaining and increasing system
security through transition

Knowledge transfer to internal staff




/2. Technical Delivery Management

M4’s technical delivery management service covers full Cloud project
initiation and lifecycle. From Discovery through Beta Live we oversee the
delivery of complex solutions through proactive participation at a
technology, commercial and innovation level. We drive integrated teams
to deliver solid technology solutions in support of key client initiatives.

MY,

DIGITAL GROUP

Service Features

» Employing various, industry standard >
methodologies and hybrid approaches

» Realising benefits of Agile approaches that >
respect formal governance

» Deploy required Product >
Managers/Owners, Delivery Managers,
PMO support and ScrumMasters >

» Delivery includes User Researchers, >
Business/Systems Analysts and DevOps >
capabilities >

» Risk management of Cloud deployment

»  Deliver continuous services to meet GDS >
service standard

»  Stakeholder and supplier management, >
ensuring deliverables are achieved

» A service for both digital and >

infrastructure based cloud projects

»  Ensure consistent, timely and open flow of
communication

»  Support Discovery, Alpha, Beta and Live
benefits realisation

M4 Digital Group- Combined Service Descriptions - G-Cloud 14

Service Benefits

Flexible approach, tailored to your requirements
and processes

Work collaboratively and perform the *critical
friend’ role

Drawing on wider M4 expertise and
communities of interest

Work collaboratively with your suppliers

Drive project delivery

Understand Cloud specific issues

Full consideration of risks, dependencies,
security and business change

Digital transformation in line with Government
requirements

Break down complex problems into manageable
deliverables

Enablement - transfer of skills and knowledge
to staff



73. Test and Quality Assurance for Cloud /
Deployment Service

From Agile, automation, performance, usability and manual testing

through to testing of entire transition to Cloud solutions, M4 provides a DIGITAL GROUP
testing service with the flexibility you need, whether digital or

traditional. Test teams can work with both traditional Prince2 and Agile
scrum processes, across Programme and Project Test Delivery.

Service Features Service Benefits
» End to End Test Management from Project » Reducing Operational Costs
inception - . » Increasing flexibility
»  Software Delivery, Technical Refresh, Data » Reducing delivery lead time by the provision of
Migration, Cloud Migration, Contract Exit. skilled specialists

» Integration, Performance, Automation,
Security, Acceptance, Accessibility, User
Acceptance Testing

» Project delivery Methodologies Traditional
Waterfall, V-Model through to
Agile/Scrum/hybrid

» Cloud IaaS, PaaS, SaaS testing models

» Support ERP, packaged application, open
source software

» Quality and test driven development

» Procurement and contract exit

» Proprietary tooling HP (Quality /Performance
Centre), IBM Rational, Collaboration Tools.

» Consultants carry active Government
clearances - SC and Disclosure Scotland

Alignment with GDS design manual
Reducing project downtime

Taking control of your solution quality
Quality control and process improvement
Knowledge transfer

Enablement

Collaboration

VVvVVvVvyVVYVYY
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74. Test Automation Service /

M4 provide cost effective Test Consultancy and Resource Services,
covering comprehensive range of Quality Assurance and Software
Testing. We develop and implement Test Automation processes D|G|TAL GROUP
supporting continuous delivery, under Agile or DevOps environments,
and provide specialist consultancy across a range of Open Source and
licenced Automation Test tools.

Service Features Service Benefits
) » Improved productivity through Automation

» End to End Test Management from Project Regression Tests

inception to delivery _ » Reusable Test Scripts
» Unit, API, UI and Performance test Automation »  Reduction in Manual Testing Time Frames
»  Test Automation Frameworks »  Alignment with GDS design manual
»  Continuous Integration Testing » Enabling Continuous Test and Delivery
> Cloud laas, PaaS, SaaS testing models »  Taking control of your solution quality
> Support ERP, packaged application, open »  Quality control and process improvement

source software » Knowledge transfer
» Quality and test driven development » Enablement
» Procurement and contract exit »  Collaboration
» Tools from Industry standard proprietary

tooling provided by HP,IBM Rational
» Consultants carry active Government
clearances - SC and Disclosure Scotland
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/5. Test Management Service /

M4 Test Management services plan, manage and coordinate all aspects

of testing through the entire project lifecycle. Test Managers provide

leadership & mentoring, as well as define test policies, test strategies DIGITAL GROUP
and test planning and reporting. Also offer in depth experience of tool

selection assessment and enablement strategies.

Service Features Service Benefits
) » Improve Software Testing Strategies
» End to End Test Management from Project » Increasing flexibility
inception to delivery » Reducing delivery lead time by the provision of

» Software Delivery, Technical Refresh, Data skilled specialists

Migration, Cloud Migration, Contract Exit Alignment with GDS design manual
» Integration, Performance, Automation, Reducing project downtime
Security, Acceptance, Accessibility Taking control of your solution quality
»  Project delivery Methodologies from traditional Quality control and process improvement
Waterfall, V-Model to Agile/Scrum/hybrid Knowledge transfer
approaches Enablement
» Cloud IaaS, PaaS, Saa$S testing models Collaboration
» Support ERP, packaged application, open
source software
Quality and test driven development
Procurement and contract exit
Standard/proprietary tooling provided by HP,
IBM Rational
» Consultants carry active Government
clearances - SC and Disclosure Scotland

VVvVVvVvyVVYVYY

vVVvyy
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/6. Testing Augmentation Services /

M4 provide cost effective Test Consultancy and Test Resource

Augmentation Services, covering comprehensive range of Quality

Assurance and Software Testing services, including: D|G|TAL GROUP
Managing Software Testing Programmes and Projects, Test Management,

Test Automation Services, Load and Performance Testing, Test efficiency

reviews, mobile application testing. Team members are verified SC/NPPV

cleared Software Testers.

Service Features Service Benefits
) ) _ » Reducing Operational Costs
» Inception to delivery utilising Model, Processes, » Increasing flexibility
Strategies and Work Practices »  Reducing delivery lead time by the provision of

» Software Delivery, Technical Refresh, Data skilled specialists

Migration, Cloud Migration, Contract Exit Alignment with GDS design manual
» Integration, Performance, Automation, Reducing project downtime
Security, Operational Acceptance, Accessibility, Taking control of your solution quality

UA Testing _ Quality control and process improvement
»  Waterfall, V-Model through to Agile Knowledge transfer

incorporating Scrum and hybrid approaches Enablement
» Cloud IaaS, PaaS, Saa$S testing models Collaboration
» Support ERP, packaged application, open

source software
» Quality and test driven development
» Procurement and contract exit
» Tools from Industry standard proprietary

tooling provided by HP,IBM Rational
» Consultants carry active Government

clearances - SC and Disclosure Scotland

VVvVVvVvyVVYVYY
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/7. User Acceptance Test Service /

M4 teams are experienced in User Acceptance Testing. We manage and

deliver the whole User Acceptance Test lifecycle and/or bolster

existing/hybrid client teams during critical phases. We ensure that DIGITAL GROUP
Cloud Configuration and associated Applications are

operable/supportable.

Service Features Service Benefits
. » Reducing Operational Costs
> iErPc(i;?ioEnmtjoUdS;irvé%C/eptance Test Project »  Increasing flexibility
»  User Acceptance Testing for BAU, Legacy > Rf_ﬂugmg dglll\(etry lead time by the provision of
and New System Developments sKiIlled specialists .
> Capturing and mapbing business » Alignment with GDS design manual
reqpuiremgents PPINg » Reducing project downtime
. e » Taking control of your solution quality
» Methodologies from tra_dltlonal Waterf_all, >  Quality control and process improvement
V-Model through to Agile/Scrum/Hybrid
) » Knowledge transfer
» Cloud IaaS, PaaS, SaaS testing models
» S ort ERP, packaged application, open Gk i
upp r P 9 PP » OP » Collaboration

source software

» Quality and test driven development

» Procurement and contract exit

» Tools from Industry standard proprietary
tooling provided by HP,IBM Rational

» Consultants carry active Government
clearances - SC and Disclosure Scotland
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78. User Research for your Cloud Journey /

User Research, ensuring that user needs are understood and factored into
the design of robust digital services, is a vital part of Cloud transformation DIGITAL GROUP
and migration. M4's User Researchers bring significant strength through

expertise and hands on experience. Our adaptive, partnership-based

approach helps clients achieve Cloud transition goals faster.

Service Features Service Benefits
» Identification of and engagement with users » Improved operational efficiency from effective
» Utilising recognised requirement gathering process design
techniques » Increased team productivity
» Creation of user stories and backlog » Better reflection of user needs and blockers
refinement in service design
» Aligning the needs of the user and business »  Collaboration with development team
requirements »  Earlier realisation of Cloud transformation
»  Work with front end and back end users benefits
» Identification of blockers, challenging where »  Use of collaboration tooling e.qg. Jira,
appropriate Confluence and Bitbucket
» A variety of methodologies employed, » Agile and iterative
including Agile, DSDM, Kanban » UAT
» Experts in UK Government Cloud transition

projects
» Understanding of GDS Service Standards
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79. ITAM; IT Asset & Software Asset /
Lifecycle Management

M4’s Information Technology Asset Management (ITAM) service assists
organisations to manage map and optimise their asset management and DIGITAL GROUP

licensing profile. This service deployment will drive down cost, deliver
increased compliance and generate increased value through real-time
hands-on service management across entire IT Estate.

Service Features Service Benefits
» Baseline of existing estate » Effective client team development via managed
» Identification and maximisation of benefits via knowledge transfer
contract audit » Ensure Compliance
»  Client support with multiple supplier integration »  Access to an experienced team of ITAM
» Design and deployment of TOM/Target Operating professionals
Model » Improved business efficiencies and cost
» Accurate capture of asset portfolio HAM, SAM, optimisation
TAM, » Optimised usage of software licenses
» Current spend reviews » Clear, easy to execute guidance
» Software and Hardware audit »  Great track record across UK Government Sector
» Software Asset Management » In depth experience of GDS Standards and
» Technical Asset Management Manual
» Hardware Asset Management »  Quick realisation of reduced IT spend
» Continuous service improvement
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80. End point vulnerability management and
remediation

Our team enables organisations to setup and manage a bespoke solution
delivering increased compliance across your IT estate. assisting
organisations to monitor and remediate their Servers and end user devices.
Delivering a dashboard of vulnerabilities mapped to criticality. Enabling
automatic application of patches and fixes and best use of resources

b

DIGITAL GROUP

Service Features

» Baseline of existing IT estate to understand scale »

of problem

» Bespoke reporting to inform risk remediation >
strategies

» Identification of criticality to maximise return on >
effort

» Automation of vulnerability remediation, >
minimising user impact

» Client support designed to meet your needs >

» We design, deliver, and support bespoke solutions »
to Client needs >

» Selecting the right tools to maximise value and >
business benefit

» Accurate capture of asset live data to inform risk >
management >

» Current trend reviews to inform management of
resources

» Supplier agnostic service, selecting the right tools
for your needs
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Service Benefits

Effective client team development via managed
knowledge transfer

Ensure Compliance with NCSC Security standards
and principles

Access to an experienced team of Security
professionals

Improved business efficiencies and cost
optimisation

Optimised usage of resources to address risk
Clear, easy to execute guidance

Great track record across UK Government Sector
In depth experience of GDS Standards and
Manual

Quick realisation of reduced IT spend
Continuous service improvement



M,

Planning DIGITAL GROUP

The M4 team is highly experienced in the analysis of current modes of operation and the creation of
roadmaps, to enable secure migration of legacy systems to Cloud.

We identify early, the capabilities needed to deliver required outcomes and work closely with clients
at all levels to deploy a flexible delivery team tailored to complement existing resources. Further we
ensure knowledge transfer and enablement and the leveraging of existing capabilities and
resources.

We review collaboratively all aspects of services including people, processes and infrastructure.
Working in partnership with stakeholders we efficiently identify opportunities and enablers, to define
and develop legacy systems to Cloud migration strategy. Our processes take into account user
requirements and interdependencies of current systems as well as appetite and capability for
change.

We leverage any opportunities to increase speed of migration and translate business plans into
delivery plans identifying both technical and financial benefits.

We focus on gaining early benefit from transition to cloud and are experienced in delivering practical
hybrid transitional solutions in adherence to the Government Digital Services Technology Code of
Practice. Planning leverages contract end dates and technology refresh timetables to ensure costs of
the old environment are bounded to deliver maximum benefit realisation.
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M,

Setup and Migration DIGITAL GROUP

Key to a successful and secure migration of legacy systems to cloud is the deep understanding of
the interaction of all associated services. Critical considerations include costs of data migration,
application redesign, application performance and availability.

Security, privacy and regulatory requirements must also be taken into account. Careful
consideration of the current environment, as well as commercial and technical constraints also need
to be clearly understood. Our team build end to end service maps for each capability, mapping the
elements of the service provision and supplier matrix to ensure all elements in scope of the
architecture design plan are captured and addressed in sequence to ensure there are no service
orphans or components. We deliver an iterative solution following the initial build of a containerised
portable environment based on tried and tested model blueprints, designed to fully comply with the
Government Digital Service Technology code of practice.

We also incorporate appropriate open source continuous integration tooling for delivery and test
automation and provide security monitoring appropriate to the risks, and in compliance with, the
Government Security Policy framework. Our team are experts in understanding functional and non-
functional requirements and mapping these to physical services and transitioning to cloud-based
equivalents.
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M,

QA and Performance Testing DIGITAL GROUP

M4’s QA and Testing function for cloud services concentrates on measuring and examining quality,
and improving software and systems capability through ongoing process improvement. This is
offered throughout the development lifecycle, with adherence to all Acceptance Criteria remaining at
the core of all activities.

We provide flexible and tailored solutions to facilitate quality delivery for our partners. We can also
provide, strategic planning and guidance and can build out, where appropriate, internal project
teams to increase depth and breadth of internal client coverage and accelerate rates of enablement.

Our teams are experienced both in conducting key analysis and making recommendations as to the
most effective toolset for the Service(s) under test. We also identify key points of measure under
test, deploy appropriate tooling, validate associated accuracy and identify risks test may impose.
Our targeted Test services are delivered by experienced team members and include: Functional,
Regression, Compatibility, Load, Integration, Acceptance, Security and Usability. Utilising tools from
industry standard proprietary tooling and collaboration tools to specific tools for Integration,
Security, Automation, Browser Validation.

Test Strategy includes, scope, approach, constraints, risks, issues and assumptions, tooling,
environment, data requirements and entry/exit criteria. Using automated unit testing and
integration testing tools to deliver.
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M,

Training DIGITAL GROUP

Enablement is a key component of M4 engagements; our goal is to deliver organisational change and
sustainable client capabilities via training, mentoring and documentation.

Our teams can assist with development, improvement and support of the client cloud environment whilst
enabling client teams to an assured level of knowledge that allows for secure handover and ongoing
maintenance of the IT estate.

Understanding that client cloud requirements, transformation programmes and support capabilities are
individual, we tailor this process to create a defined exit plan ensuring the client can manage BAU
activities and ongoing continuous improvement beyond our agreed exit date. During engagements we
encourage an environment of trust and work on, developing the skills and coaching the behaviours,
essential for cloud delivery. This is achieved by reviewing, prioritising and scheduling a timetable of
knowledge transfer activities; our consultants deliver these activities through:

» Co-location (modelling best practice)

» Code review

» Pair programming

» Peer coaching/mentoring.

Our knowledge transfer programmes support individual client requirements and align with the DDaT
Professional Capability Framework.

To support this transition the M4 team document the relevant knowledge base to support operational
running.

M4 can, in addition provide:

» Tailored Workshops

» Assistance identifying appropriate GDS Academy courses
» Introductions to Communities of Practice

M4 Digital Group- Combined Service Descriptions - G-Cloud 14



M,

Support Levels DIGITAL GROUP

During an engagement, each team has an onsite lead, as first point of call, who is supported by a
dedicated Client Management team providing full support throughout the engagement. We always
recommend agreement in advance of a suitable support plan, a service responsibility matrix and
appropriate service levels to meet the Client’s needs.

Our team will also continuously review overall contractual performance against agreed SLA’s and
regularly review with the client the service and performance of the team against agreed deliverables
and timelines. Equally, we ensure that service and programme management procedures are
followed, including the production, maintenance and monitoring of programme and risk
management plans to the satisfaction of the Client.

Standard ITIL processes are also applied by the team, aligned, as appropriate, to the Client’s
Engagement and Governance model including attendance to relevant service boards, as agreed with
the Client. Escalations received during normal office hours (Mon-Fri 9am-5pm exc. Bank Holidays)
are normally dealt with within 8 working hours. Standard support is included in the cost of the
service hour. Escalations for technical issues can be made available 24x7.
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Quality Management Statement SIETRL EREiB

M4 Digital Group Limited was established in 2013.
M4 values its customers, consultants and staff.
We strive to provide our customers with services which meet and in turn exceed their expectations.

We are committed to continuous improvement and have established a Quality Management System which
provides a framework for measuring and improving our performance.

We have the following systems and procedures in place to support us in our aim of total customer
satisfaction and continuous improvement throughout our business:

Gathering and monitoring of customer feedback
Selection and performance monitoring of consultants
Training and development for our employees and consultants

Audits of internal processes

vV v v Vv VY

Performance appraisal of all employees

Although the Managing Director has ultimate responsibility for “quality delivery”, all employees have a
responsibility within their own areas of work to ensure that the ethos of “quality delivery” is adhered to at all
times.
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Environmental Policy Statement
DIGITAL GROUP

M4 believe that businesses are responsible for achieving good environmental practice and operating in a
sustainable manner.

We are therefore committed to reducing our environmental impact and continually improving our
environmental performance as an integral and fundamental part of our business strategy and operating
methods.

It is our priority to encourage our customers, suppliers and all business associates to do the same. Not only
is this sound commercial sense for all; it is also a matter of delivering on our duty of care towards future
generations.

Principles

»  Wholly support and comply with or exceed the requirements of current environmental legislation and
codes of practice

» Minimise our waste and reuse or recycle as much of it as possible

» Minimise energy and water usage in our offices, vehicles and processes in order to conserve supplies,
and minimise our consumption of natural resources, especially where they are non-renewable

» As far as possible purchase products and services that do the least damage to the environment and
encourage others to do the same

» Assess the environmental impact of any new processes or products we intend to introduce in advance
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Social Value: Equal Opportunities M/|-
Statement DIGITAL GROUP

M4 is committed to providing equal opportunities for employees and team members and eliminating any
potential discrimination from our internal/external working practices, as per our Equality and Diversity Policy.
This commitment has enabled us to create a culture of equality and inclusivity, fundamental to the vision and
values of the company. The values of our policy are reflected in our recruitment process, alongside the daily
practice of providing a working environment where all members of the team are treated with dignity and
respect.

This policy's purpose is to:

1. Provide equality, fairness and respect for all in our employment or involved in our project teams, whether
temporary, part-time or full-time.

2. Not unlawfully discriminate because of the Equality Act 2010 protected characteristics of:
Age

Disability

Gender reassignment

Marriage or civil partnership

Pregnancy and maternity

Race (including colour, nationality, and ethnic or national origin)

Religion or belief

Sex

vV v v v v v v v v

Sexual orientation
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Social Value: Equal Opportunities M/|-
Statement continued DIGITAL GROUP

Oppose and avoid all forms of unlawful discrimination. This includes in:
Pay and benefits
Terms and conditions of employment

Dealing with grievances and discipline

3.

>

>

>

» Dismissal
» Redundancy

» Leave for parents

» Requests for flexible working

» Selection for employment, promotion, training or other development opportunities

All members of staff are responsible for supporting the aims and spirit of the policy. Our approach to equal
opportunities is disseminated to staff during their induction process upon joining the company and with
refresher training conducted yearly. All training is monitored by the Company Directors, with training logged
on our internal training matrix.

The success of our Equality and Diversity Policy commitment as part of our recruitment process is monitored
through anonymised surveys included at the end of our job application forms. This ensures we continue to

advertise positions to a diverse range of candidates, including young people not in education, employment or
training (NEET).
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Social Value: Wellbeing Statement M/|-
DIGITAL GROUP

M4 work with staff and team members to integrate health and wellbeing into day-to-day activities to
enable us to create a positive and healthy working environment. This is achieved through wellbeing
initiatives, employee support mechanisms, joint working with staff and their representatives and our local
partners to identify and address areas for improvement.

We will work with employees to ensure those issues which may impact negatively on staff health are
identified and addressed. We will ensure that managers have the key skills, knowledge and ability to support
employees to improve their health and wellbeing. We will also ensure that we increase the awareness of our
employees as to what is important in ensuring their own health and wellbeing.

There are a number of effective policies and procedures already in place to support employee health and
wellbeing, including our Mental Health and Wellbeing Strategy which outlines how we will strive to improve
mental health within our organisation. We will continue to regularly review these on a yearly basis to ensure
that they support this strategy effectively.M4 also support wellbeing in the wider community through our
charity work and commitment to corporate social responsibility. Schemes we have supported previously
include:

» A team member undertaking the Jurassic Coast Challenge in aid of Breast Cancer Now, raising £1030.
» Sponsorship of Swansea Schools Rugby Union Under 15’s.
Schemes that we currently support

» Several members of the M4 team running the Royal Parks Half Marathon in aid of Pancreatic Cancer UK,
raising a total of £13,673
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Slavery and Human Trafficking M/|-
Statement DIGITAL GROUP

This statement is made pursuant to section 54 of the Modern Slavery Act 2015.

It constitutes M4 Digital Group Limited slavery and human trafficking statement. Although we do not meet the
requirements in the Act, we have chosen to voluntarily produce a ‘slavery and human trafficking statement’ to provide a
level of assurance to our clients.

Our Organisation

Our permanent staff are directly employed and are not in any category which is generally seen to be vulnerable to modern
slavery in this country, so our focus is to ensure there are policies and procedures in place for our consultants and
suppliers.

What we are doing
Raising awareness of modern-day slavery both within our business and our supply chains is important to us.

» M4 is committed to continuously improving its practices to identify and eliminate any slavery and human trafficking in
its business and supply chains, and to acting ethically and with integrity in all its business relationships.

> M4 uses a range of suppliers who supply goods, services and support our operations. When selecting suppliers, we
assess the potential human rights risks of the supply chain by considering the country of origin where we are sourcing
products and the type of labour that might be involved in the manufacture of those products.

»  We know that identifying potential and actual cases requires upskilling colleagues and suppliers to understand the
drivers of modern slavery as well as the possible indicators.

» We make available the Gov.UK guidance documentation relating to the Modern Slavery Act through our shared
document drive.

»  Over the course of the year we will continue to monitor our procedures to help us identify, prevent and mitigate any
risks of modern slavery or human trafficking in relation to new and existing suppliers.
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